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Windows XP Performance Tips 
SouthSide Computer Club 

Terry Kerby            May 4, 2006 
 

 Performance Tweaks 
 
 1  Adjust Graphics for Speed 
 2  Application Defrag 
 3  ASPI Drivers 
 4  Automate Disk Cleanup 
 5  Backup - The easy way 
 6  CD ROM Stops AutoPlaying... 
 7  Changing CD Staging Area Folder Location 
 8  Classic Start Menu Mode (Browsing Boost) 
 9  Clean your prefetch to improve performance. 
10 Clicking AVI Files on explorer causing 100% CPU Usage 
11 Contiguous File Allocation size 
12 Convert FAT32 To NTFS 
13 Correcting System Hang at Startup 
14 Decrease system loading time by changing network settings 
15 Decrease your Applications startup time 
16 Delete Prefetch Automatically 
17 Disable automatic updating 
18 Disable auto-reboot 
19 Disable Debug Scripting in Internet Explorer 
20 Disable Indexing Services 
21 Disable Prefetch for low memory systems 
22 Disable Recent Documents History 
23 Disable Search from looking in zip (compressed) files 
24 Disable unnecessary programs 
25 Disable unnecessary programs 
26 Disable unnecessary services to free system resources 
27 Disable XP Boot Logo 
28 Disable zip folders 
29 Disabling Automatic Updates properly 
30 DMA Mode on IDE Devices 
31 Easily Disable Messenger 
32 Easy Way to Adjust LargeSystemCache 
33 Edit Hidden System Settings using Group Policy Editor 
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34 Enable or disable boot defrag 
35 Enabling/Disabling PIO/DMA 
36 Faster Boot-Up without tons of fonts 
37 Faster Dual Boot Timeout 
38 Faster startup of Windows XP  
39 Fonts: more thereon ... 
40 Free-up some more disk space 
41 Fresh Install with no ACPI (updated) 
42 Fresh install with no ACPI. 
43 Gaming Machine: Hardware Profile to free up System Resources 
44 Get rid of IM and no slow OE startup 
45 Getting More Processing Power 
46 HDD slowdown when booting 
47 Increase speed by tweaking prefetcher settings 
48 Increase XP NTFS performance 
49 Intel Application Accelerator - speed up disk access 
50 Its all about your priorities 
51 Launch apps with desired priority setting 
52 Make icons in windows appear quicker 
53 Memory Performance Tweak 
54 MFT Fragmentation 
55 Modify application timeout 
56 Modify application timeout 
57 Modify auto-reboot setting 
58 No DOZE 
59 No more low disk space messages 
60 NTFS Cluster size 
61 Open Outlook Express faster 
62 Optimize NTFS 
63 Problems enabling DMA on IDE drives 
64 Performance Increase through My Computer 
65 Reduce 10 second scandisk wait time 
66 Remove hibernation file 
67 Remove start-up items 
68 Sacrifice Graphics for Speed 
69 Service Settings for Gamers 
70 Services 
71 Services Info and Configurations 
72 Shutdown XP Faster 
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73 Shutdown XP using your keyboard! 
74 Simple Outlook express loading after msn messenger is... 
75 Skip Operating System selection on boot 
76 Slow logon to domain in XP Pro 
77 Slow network access not always due to Scheduled tasks check 
78 Smooth Mouse 
79 Speed Boot - Shave 2 Seconds 
80 Speed up boot by disabling unused ports 
81 Speed up Detailed view in Explorer 
82 Speed up Menu Appearance Without Causing Problems with zero... 
83 Speed up menu display 
84 Speed up menu display 
85 Speed up Network Browsing 
86 Speed-up log-in tremendously! 
87 Stop Jerky Graphics 
88 Stop jerky graphics. The alternative way. 
89 Stripping Page File across Multiple Hard drives 
90 System Settings for a Game Machine 
91 The System Configuration Utility 
92 Turn off disk performance monitors 
93 Turn off Indexing to speed up XP 
94 Turn off System Restore to save space 
95 Unload .dll's to Free Memory 
96 Users not interested in fancy windows and colors 
97 Very Slow boot when networking 
98 View and manage startup programs 
99 View XP System Uptime 
100 Watch movies with 'AboveNormal' priority  
101 Windows XP does have a back-up Utility!!! 
102 Windows XP Icon Cache 
103 Obtain the newest drivers for your hardware 
104 Backing up and editing the registry  
105 Creating a system restore point  
106 Saving your hard drive space from the system restore utility  
107 Editing registry settings without restarting  
108 Accessing & Updating your BIOS  
109 Overclocking your processor and memory 
110 Move the page file from system drive  
111 Create a 'permanent' page file  
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112 Optimize your page file size  
113 Check your hard drives for errors with “Chkdsk” 
114 Force XP to unload DLL files after closing a program 
115 Thaw out your desktop 
116 Change to the NTFS file system 
117 Reduce recycling bin reserved space 
118 Enable write caching on hard disks 
119 Defragment your hard disk(s) 
120 Enable AGP Fast Write  
121 Wifi 802.11b devices slow down 802.11g networks 
122 Reduce menu delays 
123 Make 'My Computer' open faster 
124 Disable floppy drive seek 
125 Enable quick POST/memory test 
126 Reduce wait time after XP boots 
127 Shutdown XP Faster 
128 Schedule a Task for Idle Time 
129 Turn off BIOS disk detection 
130 Disable boot virus detection 
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1 Adjust Graphics for Speed 

Windows XP has a lot of new cool looking visual elements, however, those new elements 
take up more RAM and cause your computer to be less responsive. By tweaking your 
graphics settings, you can increase the performance of your computer.  

To get started, Let's reduce the color quality.  This setting determines how many colors are 
displayed on your screen.   

1. Right click on your desktop and select properties.  
2. Click on the settings tab and adjust the color quality drop down box to Medium (16 

Bit).  
3. Click OK. 

Next, let's use the windows performance settings to optimize your computer for 
performance.  This will revert back to the old Windows 2000 look as well as take away a lot 
of the fancy graphics effects.  However, if you are really into performance, this is the price 
you have to pay. 

1. Right click on the My Computer icon on your desktop or in your start panel and select 
properties.  

2. Next, Click on the Advanced tab and hit the setting button under performance.  
3. On the visual effects tab, select Adjust for Best Performance and hit OK.  
4. Hit OK once more to exit system properties.  

Now your computer will run slightly faster! 

 
 
 
2 Application Defrag 

Application and Boot file Defrag 

This type of defrag pushes all commonly used programs and boot files to the edge of the 
hard drive for faster access. Windows XP normally schedules this every three days when it is 
idle, however you can force it to do this by using the b switch anytime 

i.e defrag c: -b 

 
Partially correct. The "partial defrag" that the defrag -b performs takes the boot/system files indicated 
in \prefetch\layout.ini and moves them to the first largest piece of free space where they will fit - 
regardless of where on the partition the this piece of free space is. If the space is at the beginning of 
the partition, it will put them there. If the free space is at the end of the partition, it will move them 
there. Usually, the beginning of the partition does NOT have a large enough piece of contiguous free 
space - this process will NOT clear out free space in order to place the files.  
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3 ASPI Drivers 
 
I have had some bad times trying to get CD/DVD programmers working with XP. This was 
do to the ASPI drivers which I have now downloaded and installed. PowerDVD, 
AudioCatalyst and a few others now work how they were meant to. 
 
Click Here to download the ASPI drivers from Adaptec  
 
 
 
 
4 Automate Disk Cleanup 
 
Cleanmgr.exe is designed to clear unnecessary files from your computer's hard disk. You 
can use command-line options to specify that Cleanmgr.exe cleans up certain files. You can 
then schedule the task to run at a specific time by using the Scheduled Tasks tool. 
 
To start the Disk Cleanup tool, either run the Cleanmgr.exe command, or click Start, point 
to Programs, point to Accessories, point to System Tools, and then click Disk Cleanup.  
 
Disk Cleanup supports the following command-line options:  

• /d driveletter: - This option specifies the drive that you want Disk Cleanup to clean.  
• /sageset: n - This option displays the Disk Cleanup Settings dialog box and also 

creates a registry key to store the settings that you select. The n value, which is 
stored in the registry, allows you to specify tasks for Disk Cleanup to run. The n 
value can be any integer value from 0 to 65535. To have all of the options available 
when you use the /sageset option, you might need to specify the drive where 
Windows is installed.  

• /sagerun: n - This option runs the specified tasks that are assigned to the n value if 
you use the \sageset option. 
 
For example, in Scheduled Tasks, you could run the following command after you run 
the cleanmgr /sageset:11 command:  

cleanmgr /sagerun:11 

This command runs Disk Cleanup and includes the options that you specified with the 
cleanmgr /sageset:11 command.  

 
 
 
 
5 Backup - The easy way 
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NT Backup utility is, by default, installed only with XP Pro 

 To install it in XP Home Editon double-click this file on your Windows XP install disk 
cd:\VALUEADD\MSFT\NTBACKUP\NTBACKUP.MSI 

Start>run>NTBACKUP 

 
 
 
6 CD ROM Stops AutoPlaying... 
 
...and the AutoPlay Tab has disappeared in My Computer, Devices With Removable Storage, 
Right Click on CDROM, Properties. 
 
Solution: 
The service: "Shell Hardware Detection" has been set to Manual or Disabled. Go to Control 
Panel, Administrative Tools, Services. Return this service to "Automatic". 

 
 
 
7 Changing CD Staging Area Folder Location 
 
If you have a slave drive that you would rather be fragmented by multiple CD ripping, might I 
suggest moving your temporary CD staging folder to the slave drive? Please note that this is a 
WEE bit of a security concern, since you are moving your personal files into the open & out of 
the protection of your personal folders... BUT, if you are like me and you have only yourself on 
your system, and don’t care well then LETS do it!! 

Go to this folder : 

(your root folder)\Documents and Settings\(your username)\Local Settings\Application 
Data\Microsoft\ 

Here you SHOULD have a folder called CD Burning - This is your temporary folder for CD 
burning. 

In windows explorer - move this folder (Using cut & paste) to another local drive. I don’t 
recommend moving this folder to a removable or network drive unless you are VERY 
confident in its connection reliability. 

You may also want to start up regedit and go to: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell 
Folders\CD Burning 

and change the value of CD Burning to your new folder location. 

You can reboot if you want, I don’t think you need to.... 
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Now, you SHOULD not notice any difference, other than that you are not scratching you 
your system drive to burn data CD's 

Enjoy... 

(P.S. Use this at your own risk!) 

 
 
 
8 Classic Start Menu Mode (Browsing Boost) 
 
WARNING: Keep in mind that this tweak is intended for people using the "Classic Start 
Menu" mode to browse trough the Start Menu. 
 
If your Start Menu loads right away when you click on it, but goes slow while you browse 
trough it, this will certainly solve your problem. It's quite simple actually, just follow these 
steps: 
 
1. Right Click on your taskbar and choose "Properties" 
2. Choose the "Start Menu" Tab and then click on "Customize"(Classic Start Menu :) 
Obviously) 
3. Scroll Down the "Advanced Start Menu Options" list and uncheck the "Use Personalized 
Menus" option, click "OK", then "Apply" and "OK" to finish. 
 
There's no need to reboot, you'll see the difference right away. Another good advice to keep 
you start menu working smooth is to restrict the number of programs and icons listed as 
much as possible, keep in mind that it works just like any other regular folder, the less you 
index, the faster it gets.  

 
 
 
9 Clean your prefetch to improve performance. 

This is an unique technique for WinXP. We know that it is necessary to wash registry and 
TEMP files for Win9X/ME/2000 periodly. Prefetch is a new and very useful technique in 
Windows XP. However, after using XP some time, the prefetch folder can get full of rarely 
used or obsolete links which can slow down your computer noticeably. My suggestion is: 
open C(system drive):/windows/prefetch, delete all files (or at least those more than 3 
weeks old), reboot. I recommended that you do this every month.  

Editor Note:  Deleting prefetch files too often (Every reboot) can decrease system 
performance! 

 
 
 
 
10 Clicking AVI Files on explorer causing 100% CPU Usage 
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Well windows seem to have a REALLY big problem when it comes to reading AVI files. It 
seems that when you click on an AVI file in explorer, it'll try to read the entire AVI file to 
determine the width,height, etc. of the AVI file (this is displayed in the Properties window). 
Now the problem with Windows is that if you have a broken/not fully downloaded AVI file 
that doesn’t contain this info, Windows will scan the entire AVI file trying to figure out all 
these properties which in the process will probably cause 100% CPU usage and heavy 
memory usage. 
 
To solve this problem all you have to do is the following: 
 
1. Open up regedit 
2. Goto HKEY_CLASSES_ROOT\SystemFileAssociations\.avi\shellex\PropertyHandler 
3. Delete the "Default" value which should be "{87D62D94-71B3-4b9a-9489-
5FE6850DC73E}" 
 
Voila! Please note that this will no longer provide you with the windows properties displaying 
the AVI file information such as width, height, bitrates etc. But it’s a small price to pay for 
saving you resources. 
 
NOTE: Please use caution when using regedit. Improper usage may cause windows to 
behave incorrectly. Also, I cannot be held responsible. Backup your registry first. 
 
 
 
 
11 Contiguous File Allocation size 

This setting optimizes the contiguous file allocation size for the file system and can be 
especially useful for disk intensive applications. Open up your registry and go to:  

 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\FileSystem  
Create a DWORD value named 'ConfigFileAllocSize' and set the value to '200' (in hex) or 
512 (decimal) 

 
 
 
12 Convert FAT32 To NTFS 

To change from FAT 32 to NTFS file system for more stability, security and less 
fragmentation, open the command prompt and type: 

 Convert C: /FS:NTFS 

 "C" being the drive you wish to convert. Make sure there is a space between the C: and the 
forward slash (/). Once you press enter it will ask you for confirmation and press Y. Then 
press Y and enter once more to reboot.. This also works for windows XP Home. 
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13 Correcting System Hang at Startup 

If your system hangs about 2 or 3 minutes at startup, where you can't access the Start 
button or the Taskbar, it may be due to one specific service (Background Intelligent 
Transfer) running in the background. Microsoft put out a patch for this but it didn't work for 
me. Here's what you do: 
 
1. Click on Start/Run, type 'msconfig', then click 'OK'. 
2. Go to the 'Services' tab, find the 'Background Intelligent Transfer' service, disable it, 
apply the changes & reboot.  

  

This problem with the Background Intelligent Transfer Service should have been corrected 
in Windows update Q 314862, part of Service Pack 1. (yoyo) 

 
 
 
14 Decrease system loading time by changing network settings 
 
When you start up your computer and you are connected to a LAN and your computer is set 
to DHCP and your computer has to search for the DHCP server and then request and IP 
address and all other configuration.  This process takes up some time and slows down the 
time it takes to boot the computer up.   Following the directions below will help your set a 
static IP address.  Even if your ISP says to use DHCP this tweak may still work for you, but 
you are warned!  

1. Click Start and click on Run.  
2. Type command in the text box and click OK.  
3. In DOS, type ipconfig and hit enter.  
4. This will show you your current IPs that your NIC and PPPoE adapters have. Only pay 

attention to your Ethernet Card Adapter, not to the PPP adapter.  
5. Next, right click My Network Places and select Properties from the drop down menu. 

This will open up the Network Connections window. In here, locate your Local Area 
Network connection and right click it, select Properties from the drop down menu.  

6. When the next Window that opens up, select Internet Protocol (TCP/IP) and click 
Properties at the bottom.  

7. In the next window, click 'Use the following IP Address'.  This is where that DOS 
window comes in handy. Copy the same exact IP Address from your Ethernet card 
(in the dos window) and place it where it says IP Address. Same goes for the Subnet 
Mask and Default Gateway. If your Default Gateway is blank, then just leave it blank. 
Click Ok, then Ok again.  

8. In the DOS window type exit dos then enter. Reboot your machine.  

Now there is absolutely NO loading. You can connect as soon as you see your desktop. 
 
Quick Note: If you use DHCP (Dynamic IP Address) to connect to the net, you may find that 
your net connection does not work after this. So if some day your network connection stops 
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working, just go back into the NIC card properties and select automatically get IP address 
and reboot. 

 
 
 
15 Decrease your Applications startup time 

By default, Microsoft includes the /prefetch:1 switch to speed up it's Windows Media Player 
application start time.  This switch can be used for other Windows applications and also 
many third party programs. 

Example #1 

You have AOL 8.0 installed on the computer. Complete the steps outlined bewlo to add the 
/prefetch:1 switch to AOL's Target path. 

1. Right click on the AOL shortcut and select properties from the menu. 

2. In the Target: Field add the /prefetch:1 switch to the very end of the path, like 
this:  "C:\Program Files\America Online 8.0\aol.exe" /prefetch:1 and then click ok.  

Now start AOL. It would load at least 50 times faster than ever before. 

Example #2  

1, Go to the Start button/All Programs/Accessories/System Tools  

2. Right click on System Restore and select properties from the menu that appears. Add the 
/prefetch:1 to the Target Path entry so it looks like 
this %ystemRoot%\System32\restore\rstrui.exe /prefetch:1 and click ok. 

Now System Restore will start immediately when executed. 

Note: This switch will only work with some programs. Others will 
return a message saying the program in the target box is invalid. 
Just remove the switch (by Allan, forum admin). 

 
 
 
 
16 Delete Prefetch Automatically 

Here's an easy way to delete your prefetch -- Automatically!! 

1. Go into My Computer and go into your hard drive. 
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2. Right-click anywhere that a file is not and select the 'New' submenu and click 'Text 
Document' 

3. Name it "deleteprefetch" 

4. Double-click on the text file you just created. 

5. Type "del C:\Windows\Prefetch\*.* /Q" (without the quotes). 

6. Go to File > Save As... and choose "All Files" from the "Save as Type" box and save it as 
"deleteprefetch.bat"  

7. You just created a batch file that will automatically delete all the files in your Prefetch folder. 
Congrats. 

Note: For more information on Prefetching see the following URL: 

http://www.microsoft.com/whdc/hwdev/platform/performance/benchmark.mspx  

 
 
 
17 Disable automatic updating 
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To save memory and CPU time turn off the automatic update system in windows.  You can 
always check manually for updates and most users have no problem with that.  For those of 
you lazy bums out there you can leave this feature on but I warned you. 

1. Open control panel. 
2. (if using XPstyle control panel, click on performance and maintenance.) 
3. Click on System. 
4. Then click on the automatic updates tab and select Turn off automatic updating. 

If Service Pack 1 is installed uncheck Keep my computer up to date. 
5. Click Ok. 

 
 
 
18 Disable auto-reboot 
 
When Running windows and it crashes you will get a blue screen and it will automatically 
restart, ofter it will restart too fast for you to see the error message. You could check the 
error log in this case but that is too easy. We are going to disable auto restart on system 
failure. 
 
1. Go to Start -> Control Panel -> System (Windows+Pause works, too)  
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2. Go to Advanced  
3. Under the Startup and Recovery section, click Settings...  
4. Under System Failure un-check "Automatically restart"  
 
 
 
 
19 Disable Debug Scripting in Internet Explorer 
 
Don't you hate it when you are browsing a page it asks you "Would you like to debug this 
page?" Well here's a nifty and easy way to turn it off. 
 
Right Click on Internet Explorer and Click Properties 
----- or ----- 
Open Internet Explorer. Click Tools | Internet Options 
 
Click The "Advanced" Tab 
 
The 4th Item in "Browsing" should say "Disable Script Debugging" 
 
Check it and you are all set! Enjoy a Debug-Free Browsing experience.  

 
 
 
20 Disable Indexing Services 

Indexing services is a small program that hogs HUGE amounts of RAM and can often make a 
computer endlessly loud and noisy.  This system process indexing and updates lists of the 
files on your system, so you can search for them quickly, but it's completely unnecessary. 

To disable it, go to the Control Panel and click Add/Remove Programs.  Click the 
Add/Remove Window Components.  Simply unclick the Indexing services and click next! 

Indexing service creates a database index of all files on your system 
when the system is otherwise idle. Unless you do frequent searches, 
it is suggested you disable this service.  

 
 
 
21 Disable Prefetch for low memory systems 

If you're like me your system only has about 128megs of RAM.  The Windows XP Prefetch 
can take a lot of this up by preloading programs at boot as well as preloading programs you 
often use thus sucking away your available RAM. 

On my system, a Dell PIII 866 with 128 megs of RAM, I was able to greatly boast my 
system performance by disabling Prefetch all together.  It used to take a half hour for the 
disk to stop thrashing after stopping Nortons SpeedDisk,  Now it stops instantly. 
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Note:  This tweak worked for this user and their system configuration but disabling prefetch 
on other systems may have a bad effect as it might free up ram but it also could increase 
program start up time. 

Here's how to disable Prefetch. 

1. run "regedit"; 
2. goto [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\Memory Management\PrefetchParameters\EnablePrefetcher]; 
3. Set the value to either 0-Disable.  
4. reboot. 

 
 
 
22 Disable Recent Documents History 

Normally when you open or access a document or file it is added to the list of recent 
documents on the Start Menu. This tweak will stop files from being added to the list.  

Open your registry and find the key below.  

Create a new DWORD value, or modify the existing value called 'NoRecentDocsHistory' set 
the value to equal '1' to enable the restriction.  

Exit your registry, you may need to restart for the changes to take effect.  

(Default) REG_SZ (value not set) 

NoRecentDocsHistory REG_DWORD 0x00000001 (1) 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\... 

Registry Settings 
User Key: [HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\ 
Explorer] 
System Key: [HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\ 
Explorer] 
Value Name: NoRecentDocsHistory 
Data Type: REG_DWORD (DWORD Value) 
Value Data: (0 = disable restriction, 1 = enable restriction) 

 
 
 
23 Disable Search from looking in zip (compressed) files 

Windows XP Search can get slow if you have a lot of compressed files on your hard drive. 
Speed up your searches by disabling this. Open the Run command and type the following:  
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regsvr32 c:\winnt\\system32\zipfldr.dll /u or  

regsvr32 c:\windows\\system32\zipfldr.dll /u if installed in the windows directory  

To turn this feature back on: 

regsvr32 c:\winnt\\system32\zipfldr.dll or 

regsvr32 c:\windows\\system32\zipfldr.dll if installed in the windows directory 

 
 
 
24 Disable unnecessary programs 
 
When you install some programs they will insert themselves into an area of your registry 
that will cause them to load when your computer starts up. Obviously this will use memory 
and slow down your system.  

1. Start Regedit.   
2. Navigate to 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\ Run  
3. Once there, locate any entry's on the right.  You can identify the program by the 

path to the executable.  Find programs that you can live without starting up from the 
list.  

4. Right click on them and select Delete  
5. You may also want to navigate to 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\ 
Runonce and 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion 
\Run.  

6. Delete unnecessary programs.  
7. Also go to START - PROGRAMS - STARTUP and see if there is anything there you 

wish to remove.  
8. Reboot your computer. 

 
 
 
 
25 Disable unnecessary programs 

You will find that many of the programs you install on your system set portions of 
themselves to run automatically when you start up your computer. Each program that runs 
on startup not only consumes system resources but also extends the length of time it takes 
your PC to fully boot.  

Since it is generally unnecessary to have any programs running in the background (other 
than security software like virus-scanners or firewalls) disable your unwanted startup 
programs to increase your startup speed and conserve system resources.  
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The easiest way to go about this task is to use the MSCONFIG utility, which may be familiar 
to users of Windows 9x. This handy program contains a list of software which is set to start 
when you boot your PC. You can then easily disable and re-enable (if necessary) these 
items. 

Go to 'start\run' and type 'msconfig' to access the utility. 

The 'startup' tab in MSCONFIG provides access to several other applications that are started 
at boot up and are running in the background. By examining their Filenames and 
directories, you should be able to get a feeling for what is necessary and what is not.  

Be aware than several viruses and worms have a habit of disguising themselves with 
authoritative sounding Windows system file names, such as the Win32.spybot.worm as 
MSCONFIG32.EXE. Leave these for now if you are not sure. 

The next place you should go is 'start\programs\startup' which is a directory Windows XP 
uses to launch application shortcuts on boot-up. If you remove the shortcuts from this 
directory, the applications will not load on startup. This directory can also be a repository for 
various badness such as spyware and virus software, so if there are files here which are not 
shortcuts and you don't recognize them, you may wish to consider removing them anyways, 
as Windows will not place critical files in this directory. 

 
 
 
26 Disable unnecessary services to free system resources 

Services are programs that run when the computer starts up and continue to run as they aid the 
operating system in functionality.  There are many services that load and are not needed which 
take up memory space and CPU time.  Disabling these services will free up system resources 
which will speed up your overall computer experience.  I recommend that you sort through the 
list and read the descriptions to decide if you need that service depending on what you want to do 
with your computer.  Remember, you can always turn the service back on if you find that you 
need it in the future. Below is the procedure to turn off a service. 
 

1. Click the start button. 

2. Select run from the bottom of the right column. 

3. Then type services.msc in the box and click ok.  

4. Once the services window has loaded we are ready to turn off unneeded services.  

5. For instructional purposes we are going to turn off the Portable Media Serial 
Number service.  

6. Find this service in the list and select it with the mouse.  

7. Right click and select Properties.  
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8. Once the properties windows has loaded locate the Start up type drop down box 
and select disable.  

9. Then just click ok and the next time the computer starts the service will not be 
loaded. 

 

 
 
 
 
27 Disable XP Boot Logo 

It is possible to disable XP splash screen, which will slightly speed up the overall boot 
process. Be aware that removing the splash screen will also cause you not to see any boot-
up messages that might come up (chkdsk, convert ... ), but if your system runs without any 
problems then it should not matter. 
 
1. Edit boot.ini 
2. Add " /noguiboot" right after "/fastdetect". 

(or check the /noguiboot switch in msconfig on the boot.ini tab) 
 
Upon restarting, the splash screen will be gone. It can be re-enabled by removing the new 
switch. 

 
 
 
28 Disable zip folders 
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Are the ZIP folders too slow for you? Disable it by unregistering the file zipfldr.dll. 
 
regsvr32 /u zipfldr.dll  
 
 
 
 
29 Disabling Automatic Updates properly 

A lot of people already know about Automatic Updates and how to disable them by selecting 
the appropriate option from within the Automatic Updates tab in My Computer.  A lot of you 
might not realize this, but the Automatic Update service still runs even when you select to 
disable it here.  To turn it off completely and for good do as follows: 

1.  Go into Control Panel > Administrative Tools > Services. 

2.  Highlight the service called "Automatic Updates".  You will know when you have the 
correct one because you will see a description about it telling you what it does. 

3. Right click once highlighted and click stop to terminate the service. 

4. Right click on it again and go to Properties.  Half way down the first tab there is "Startup 
Type:" change this to disabled. 

Congratulations.  You have now disabled Automatic Updates service.  Not only will this 
make certain the service won't run, but by disabling it properly you are freeing up system 
resources as they won't be diverted to running a service that you don't use. 

 
 
 
 
30 DMA Mode on IDE Devices 

Just like Windows 2000, Windows XP still fails to set the DMA mode correctly for the IDE 
device designated as the slaves on the primary IDE and secondary IDE channels. Most CD-
ROMS are capable of supporting DMA mode, but the default in XP is still PIO. Setting it to 
DMA won't make your CD-ROM faster, but it will consume less CPU cycles. Here's how: 
 
1. Open the Device Manager. One way to do that is to right click on "My Computer", select 
the Hardware tab, and Select Device Manager. 
2. Expand "IDE ATA/ATAPI Controllers" and double-click on "Primary IDE Channel" 
3. Under the "Advanced Settings" tab, check the "Device 1" setting. More than likely, your 
current transfer mode is set to PIO. 
4. Set it to "DMA if available". 
 
Repeat the step for the "Secondary IDE Channel" if you have devices attached to it. Reboot. 

(Note: You will not see the Advanced Settings section if your hardware does not support it) 



Page 20 of 70 
 
C:\Documents and Settings\Terry\My Documents\SSCC May 2006\Windows XP Performance Tips.doc 
Windows XP Performance Tips  Terry Kerby  Compiled from various sources. 

 
 
 
31 Easily Disable Messenger 

Open Task Manager (Start - Run - taskmgr.exe) 

Go to processes tab and verify "msmsgs.exe" is not running. If it is click on the process and 
choose "End Process" 

Go into your Program Files folder.  

Rename the Messenger folder to "MessengerOFF"  

If you are unable to rename the folder in this manner then boot to safe mode and make the 
change. 

 
 
 
 
32 Easy Way to Adjust LargeSystemCache 
 
Normally, the tweak I've seen asks you to go into 
HKLM\System\CurrentControlSet\Control\Session Manager\Memory Management and 
change the value to either O or 1 to the adjustment the 
LargeSystemCache. 
 
However, in Windows XP, all you have to do is: 
 
1. Right click My Computer 
2. Select Properties 
3. Click Advanced 
4. Choose Performance 
5. Click Advanced again 
6. Select either Programs or System Cache under Memory Usage. 
 
Programs = 0 for the registry tweak equivalent 
System Cache = 1 for the registry tweak equivalent 
 
From arstechnica.com: 
On NT Server (in this case XP), the Large System Cache option is enabled, but disabled on 
Workstation. The two different settings effect how the cache manager allocates free 
memory. If the Large Cache option is on, the manager marks all the free memory, which 
isn't being used by the system and/or applications, as freely available for disk caching. On 
the flip-side (with a small cache), the manager instead only sets aside 4MB of memory for 
disk caching in an attempt to accelerate the launch of applications. Or in a more technical 
approach, if enabled the system will favor system-cache working sets over process working 
sets (with a working set basically being the memory used by components of a process).  
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33 Edit Hidden System Settings using Group Policy Editor 
 
Windows XP Pro has a great program called Group Policy Editor that allows system 
administrators to modify the settings to a great number of windows features. TO start the 
program up follow the directions below.  
 
1. Open the start menu and click Run 
2. Type gpedit.msc 
3. The Group Policy MMC appears 
4. Click through the different nodes of the tree to see all the hidden features of Windows XP 
that you can edit without touching the registry. 
 
Examples: Changing IE displays, Clearing the pagefile at shutdown, boot-time defrag 
settings, and many many more 
 
Another tip is to add this to your Administrative Tools by adding the shortcut to gpedit.msc  
 
 
 
 
34 Enable or disable boot defrag 

A great new feature in Microsoft Windows XP is the ability to do a boot defragment.  This 
places all boot files next to each other on the disk to allow for faster booting.  By default 
this option in enables but on some builds it is not so below is how to turn it on. 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  

2. Navigate to 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Dfrg\BootOptimizeFunction  

3. Select Enable from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to Y to enable and N to disable.  
6. Reboot your computer.  

 
 
 
 
35 Enabling/Disabling PIO/DMA 

To enable or disable PIO/DMA modes simply follow these steps: 

Open Device Manager: Start - Run - DevMgmt.msc  

Expand the category "IDE ATA/ATAPI Controllers" 

Right click the desired IDE controller (Primary/Secondary) and choose Properties. 
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Choose the "Advanced Settings" tab. 

Change "Transfer Mode" as necessary. 

  

Note: This option will only be available on hardware that supports this feature. If you are 
unsure please contact your hardware manufacturer. 

 
 
 
36 Faster Boot-Up without tons of Fonts 

Many of the files that load during the boot-up process are fonts.  You probably only use a 
handful of them.  I suggest moving some you never use into another folder.  You won't be 
able to access the fonts in Word or Notepad. 

1. Create a New Folder by right clicking on desktop.  New>Folder.  
2. Open "Fonts" in Control Panel.  Switch to Classic View to find them easier.  
3. Highlight a group of fonts you never use and move them to the other folder. Repeat 

if you have tons of fonts.  
4. Put the folder into My Documents for easy access.  
5. Reboot and see if it starts any faster for you.  If not, just copy the fonts back to 

the original font folder.  

Another Method: 

Create a new directory called 'font backup' or something similar on your c: drive. 

Go to 'start\control panel\fonts' and select all fonts (for now, we will be more selective 
later). Drag and drop all the fonts into the backup folder you just created. Things will get 
garbled for a moment, never fear. Windows XP will automatically re-install the base fonts 
that it needs to display text into the font’s folder in a second or two.  

Now you have the bare minimum of fonts installed. Go through the backup folder and cherry 
pick the fonts that you are sure to use (like Times New Roman or Arial). 

If you removed a large volume of fonts, your system should now boot faster. 

 
 
 
37 Faster Dual Boot Timeout 

If you dual boot your PC using Windows XP's dual boot process, you can reduce the timeout 
period your PC uses before booting to the default OS.  This tweak is useful if you boot to the 
default OS most of the time and only boot to the other OS's on a limited basis. 
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1) Locate and Open the hidden file "boot.ini" in notepad or your favorite text editor. This file 
will likely be in the root directory on the boot partition of your "master" HD.  For example, 
mine is located in "C:\boot.ini" even though I have Win98 loaded on this partition and the  
boot.ini file was generated when I loaded WinXP on "D:/" 

2) Locate the line - timeout=30 (default is 30 seconds).  Change this value to any time 
desired.  I chose 10.  Be careful not to choose too low of a setting or you may not have time 
to select your other OS's.  Also, be careful not to change other lines as this may prevent 
your PC from booting at all. 

3) Save the file.  The next time you boot your PC, the changes will take effect. 

  

Editor's note: You can also adjust this in Control Panel > System > Advanced > Startup and 
Recovery > Settings > Time to display list of operating systems 

 
 
 
 
38 Faster startup of Windows XP  

If your computer takes a long time to become useable after starting up or logging on, or 
you want a clean boot of Winodws XP try this, 

Click Start > Run > Type "msconfig"  > On the Startup tab click Disable All and on the 
Services tab check the Hide All Microsoft Service box and then click Disable All. Click Restart 
and Windows XP will restart with only the system services and applications running resulting 
in a vey fast logon / startup. 

N.B This tweak will disable all non-system startup services and applications so if you have 
anything you want to run in the background such as anti virus software do not disable that 
item. 

Note from tweakxp Staff - While this tweak will do what it promises, it's not one we 
recommend. Rather, we suggest you visit the Common Questions area in our support forum 
and follow the directions in the Services post to disable unnecessary services. - Allan 

 
 
 
39 Fonts: more thereon ... 

As a relative beginner, wrestling with fonts is making me fairly frantic, but I found 
something ... 

First off, I open the fonts folder. Then I simplify the whole matter by clicking on toolbar 
View drop down, and click on the "Hide variations" phrase, (three-quarters down the menu.) 
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Font variations disappear, simplifying the matter. This may be helpful for people with a 
couple hundred fonts or more. 

My XP Home system, seems to let me select all fonts (from Edit drop down in Windows 
explorer toolbar, once I open the fonts folder), and let me 'delete' from a pop up menu 
inside the opened fonts folder in right pane (the big one.) Then, it tells me access is denied 
to one font, so I click OK on that Grey pop up message. The other fonts seem to negotiate 
themselves nicely under this deletion process, with Windows only deleting the ultimately 
unnecessary ones (apparently!) 

This is after much unnecessary searching on the Internet for real and complete info on 
fonts saving and removal (how-to, what to keep, how to determine what to keep, etc.) 
Don't bother: stick with the above for now. 

Note: your Word program may add extra fonts to your system.  

Also: if leery of this process, you can at least satisfy yourself by getting rid of some more 
obviously needless fonts, like Gautama or whatever, assuming your system lets you, as per 
the above.  

You can always reload your fonts from some process involving your operating system disc, 
or perhaps even download them from some location on the Internet, should you decide you 
need those old deleted fonts back. I just delete them, and don't even bother to make a 
separate folder for them. 

(If you do make a separate folder for unused fonts, for rescue later, if need be, I wouldn't 
put them in a sub folder of the regular Fonts folder. I'd rename it something entirely out of 
its alphabetical realm. Maybe you could store them in Program folder, away from the 
Windows operating system folder entirely. That should guarantee Windows from doing any 
possible searching of any possible kind, in the extra folder for unneeded fonts, and slowing 
your system down, especially at boot up. This is the whole point of this 'negotiation of the 
fonts' problem.)   

(Note also that apparently Windows needs some surplus and apparently useless fonts, 
because it does "other things" with them. This is researchable on the Internet, for those 
who need to know.) 

 
 
 
40 Free-up some more disk space 

Windows XP uses a file called hiperfil.sys to save everything it needs when Windows XP 
goes into hibernation. If you are like me, and never use the hibernate function, you can turn 
it off. By turning hibernate off, Windows XP deletes the hiberfil.sys. This can free up the as 
much disk space as the amount of ram that you computer has. 

Go to Control Panel/Power Options/Hibernation and uncheck the box. It's as easy as that. 
Now you will have plenty more disk space to install those mega programs! 
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41 Fresh Install with no ACPI (updated) 
 
Here is an easier way to do the Fresh Install with no ACPI. When setup is loading, the blue 
screen will ask if you have any raid devices, and to press F6. When it does that, press and 
hold F7, & Congratulations! No ACPI will be installed.  
 
 
 
 
42 Fresh install with no ACPI. 
 
Just press F5 after the first screen asking 
if you have raid devices to install (will ask at 
bottom of screen to press F6) keep pressing F5 to second screen where it will ask to press 
F2 for recovery console. Keep holding F5 and should get another screen where it will say 
that it cannot recognize type of pc. There you have two choices: standard pc and other. 
Select standard and voila no ACPI will be installed.  
 
 
 
 
43 Gaming Machine:  
         Hardware Profile to free up System Resources 

Instead of disabling HW and stopping services, let's say for gaming, create a Hardware 
Profile. 

Right click on My Computer - select Properties. Select Hardware Tab, then click Hardware 
Profiles. 

Mark "Original Configuration", then Copy and then Rename to e.g "Game" Now you have 
created a menu that shows up when you boot your computer. Set the properties for your 
boot option in the "Hardware profiles selections" You normally would boot with the Original 
Configuration. Never delete your "Original Configuration" if you boot in another profile. 
Reboot your computer to see that this takes effect.  

Now, to tweak the different services for a Game Machine listed in this document 

http://www.tweakxp.com/tweakxp/display.asp?id=114 

Select each service to configure, right-click, select Properties, Choose "Log on" tab. In the 
lower part of this box select "Disable" or "Enable" dependent on which hardware profile you 
configure. If you configure for "Game" you choose "Disable" to free  up system resources. 

Careful: You can also disable/enable different hardware in the Device Manager - "Device 
Usage" box according to what Hardware profile you boot on, this is only recommended if 
you have any hardware that causes problems for games, etc. 
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Also; if you configure Virtual Memory according to this document 
http://www.tweakxp.com/tweakxp/display.asp?id=203 
you should set "Initial Memory" and the "Maximum" to be the same to avoid this pagefile to 
be defragmented, i.e you get better performance. Use 384 MB pagefile if you have installed 
256 MB RAM. (256MBx1.5=384MB, Microsoft.) 

If you used XP "clean-up" on your hard disk, then defragmented it, the PC would perform 
even better. Enjoy. 

 
 
 
44 Get rid of IM and no slow OE startup 
 
If you have OE 6 got to tools > windows messenger > options > preferences and in the 
general area uncheck "run this program when windows starts" and "allow this program to 
run in the background." After doing this IM does not load on startup and OE loads as usual. 
Hope it helps.  
 
 
 
 
45 Getting More Processing Power 

A clarification is needed on Spongebob's Tweak post for getting more processing power. 

"In the Run box, type "Rundll32.exe advapi32.dll,ProcessIdleTasks".  This frees up any idle 
tasks running in the background so that Windows XP can devote its full attention to what 
you want it to do.  For example playing graphic intensive games." 

While it DOES free up idle tasks, according to Microsoft, it can take up to 15 minutes to do 
so. You would not want to run this task before playing a game or using your machine as it 
will actually cause any tasks waiting for the system to become idle to be performed 
immediately. 

Quote from Microsoft: 

"When called from the command line, the ProcessIdleTasks work is done in the background 
asynchronously. It can take 10 to 15 minutes for idle tasks to complete. Task Manager will 
report processes running, and the disk will likely be active during this time" 

 
 
 
 
46 HDD slowdown when booting 
 
If, like I had , you have a 3min+ or slower boot time where Windows XP seems to sit for 2+ 
or so minutes with the XP logo doing nothing before everything comes to life, then do the 
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following.  
 
Download Bootvis from www.microsoft.com and run it the next time you boot. Do a 'Trace'  
If it shows a very long 'HDD init' time of minutes rather than seconds then this is how to fix 
it. 
 
This example assumes you have 1 Hard drive on your primary IDE channel and a DVD-
ROM(or CD)  
and CD-R on your two secondary IDE channels. 
 
Go to start > right click on my computer > click properties. Click Hardware > Device 
Manager. 
 
Go to IDE/ATAPI Controllers. Select primary channel. Right click properties. Click the 
Advance settings tab. Then on the device (0 or 1)that does not have 'device type' greyed 
out select 'disable' instead of 'autodetect'. This should stop windows trying to find a drive 
that isn't there. 
 
If you have your IDE channels set up differently simply repat the above for the secondary 
IDE channel settings.  
 
When I did this my boot time went from 3mins 20 to 35 seconds. 
 
 
 
 
47 Increase speed by tweaking prefetcher settings 

This is an unique technique for XP, which could improve the performance significantly by 
tweaking the prefetcher (which is a cache folder).  

1. run "regedit"; 
2. goto [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\Memory Management\PrefetchParameters\EnablePrefetcher]; 
3. Set the value to either 0-Disable, 1-App launch prefetch, 2-Boot Prefetch, 3-Both ("3" is 
recommended).  
4. reboot. 
 
It should decrease the boot time and the time it takes to load programs. 

 
 
48 Increase XP NTFS performance 

Last access time stamps 
XP automatically updates the date and time stamp with information about the last time you 
accessed a file. Not only does it mark the file, but it also updates the directory the file is 
located in as well as any directories above it. If you have a large hard drive with many 
subdirectories on it, this updating can slow down your system. 
 
To disable the updating, start the Registry Editor by selecting Run from the Start menu, 
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typing regedit in the Open text box, and clicking OK. When the Registry Editor window 
opens, navigate through the left pane until you get to 
 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Filesystem 
 
In the right pane, look for the value named NtfsDisableLastAccessUpdate. If the value 
exists, it's probably set to 0. To change the value, double-click it. You'll then see the Edit 
DWORD Value screen. Enter 1 in the Value Data field and click OK. 
 
If the value doesn't exist, you'll need to add it. Select New | DWORD Value from the Edit 
menu. The new value will appear in the right pane, prompting you for a value name. Type 
NtfsDisableLastAccessUpdate and press [Enter]. Double-click the new value. You'll then see 
the Edit DWORD Value screen. Enter 1 in the Value Data field and click OK. When you're 
done, close Regedit. Your registry changes will be saved automatically. Reboot your 
workstation. 
 
The Master File Table 
The Master File Table (MFT) keeps track of files on disks. This file logs all the files that are 
stored on a given disk, including an entry for the MFT itself. It works like an index of 
everything on the hard disk in much the same way that a phone book stores phone 
numbers. 
 
NTFS keeps a section of each disk just for the MFT. This allows the MFT to grow as the 
contents of a disk change without becoming overly fragmented. This is because Windows NT 
didn't provide for the defragmentation of the MFT. Windows 2000 and Windows XP’s Disk 
Defragmenter will defragment the MFT only if there’s enough space on the hard drive to 
locate all of the MFT segments together in one location. 
 
As the MFT file grows, it can become fragmented. Fortunately, you can control the initial 
size of the MFT by making a change in the registry. Making the MFT file larger prevents it 
from fragmenting but does so at the cost of storage space. For every kilobyte that NTFS 
uses for MFT, the less it has for data storage. 

To limit the size of the MFT, start the Registry Editor by selecting Run from the Start menu, 
typing regedit in the Open text box, and clicking OK. When the Registry Editor window 
opens, navigate through the left pane until you get to 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Filesystem 

In the right pane, look for the value named NtfsMftZoneReservation. If the value doesn't 
exist, you'll need to add it. Select New | DWORD Value from the Edit menu. The new value 
will appear in the right pane, prompting you for a value name. Type NtfsMftZoneReservation 
and press [Enter]. Double-click the new value. You'll then see the Edit DWORD Value 
screen. 
 
The default value for this key is 1. This is good for a drive that will contain relatively few 
large files. Other options include: 

• 2—Medium file allocation  
• 3—Larger file allocation  
• 4—Maximum file allocation 

 
To change the value, double-click it. When the Edit DWORD Value screen appears, enter the 
value you want and click OK. Unfortunately, Microsoft doesn't give any clear guidelines as to 
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what distinguishes Medium from Larger and Maximum levels of files. Suffice it to say, if you 
plan to store lots of files on your workstation, you may want to consider a value of 3 or 4 
instead of the default value of 1. 
 
When you're done, close Regedit. Your registry changes will be saved automatically. Reboot 
your workstation. Unlike other registry changes, which take place immediately for maximum 
benefit, NtfsMftZoneReservation works best on freshly formatted hard drives. This is 
because XP will then create the MFT in one contiguous space. Otherwise, it will just modify 
the current size of the MFT, instantly fragmenting it. Therefore, it's best to use this if you 
plan to have one drive for data and another for applications. 

Short filenames 
Even though NTFS can support filenames with 256 characters in order to maintain backward 
compatibility with DOS and Windows 3.x workstations, Windows XP stores filenames in the 
old 8.3 file format as well as its native format. For example, if this article is named 
"Increase XP NTFS performance.doc," Windows XP will save this file under that filename as 
well as INCREA~1.DOC. 
 
To change this in the registry, start the Registry Editor. When the Registry Editor window 
opens, navigate through the left pane until you get to 
 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Filesystem 
 
In the right pane, look for the value named NtfsDisable8dot3NameCreation. If the value 
exists, it's probably set to 0. To change the value, double-click it. In the Edit DWORD Value 
screen, enter 1 in the Value Data field and click OK. 
 
If the value doesn't exist, you'll need to add it. Select New | DWORD Value from the Edit 
menu. The new value will appear in the right pane, prompting you for a value name. Type 
NtfsDisable8dot3NameCreation and press [Enter]. Double-click the new value. You'll then 
see the Edit DWORD Value screen. Enter 1 in the Value Data field and click OK. When you're 
done, close Regedit. Your registry changes will be saved automatically. Reboot your 
workstation. 
 
Other ways to speed drive access 
There are other ways to speed drive access that aren't NTFS-specific. These include: 

• Caching—If your XP workstation has more than 256 MB of RAM, you might be able 
to increase hard drive access speeds by tweaking the amount of RAM cache that XP 
uses. For more information about how to do this, see the article "Squeeze more 
performance out of Windows XP with CachemanXP 1.1."  

• Striping—If you have more than one hard drive on your system, you can use XP's 
striping feature to have the file system store data across multiple drives. This feature 
works best with SCSI drives, but it can work with multiple ATA drives as well. You'll 
make the change using the Logical Disk Management service in the Computer 
Management utility.  

• Defragmenting—Even though NTFS is more resistant to fragmentation than FAT, it 
can and does still fragment. You can either use XP's built-in defragmenter or a third-
party utility such as Diskeeper.  

• Disable Compression—Compressing files may save space on your workstation's 
hard drive, but compressing and decompressing files can slow down your system. 
With the relative low cost of hard drives today, investing in an additional hard drive 
is better than compressing files on a workstation. 
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49 Intel Application Accelerator - speed up disk access 

It would be great to download drivers that sped up your hard-disk access by 10's of percent 
wouldn't it? Well perhaps you can, Intel has made their Application Accelerator (IAA) 
available since last September. It reduces storage sub-system bottlenecks apparently. If 
you have a compatible Intel chipset (810 to 860) and a Pentium Celeron, III , 4 or Xeon 
chip then get on down to : 
 
http://www.intel.com/support/chipsets/iaa 
 
Read through everything before you start downloading and installing. You may need to pre-
install the Intel Chipset Software Installation Utility if you have XP running on a 830 or 845 
chipset. Intel also provide a chipset identification utility if your unsure of what you have - 
it's linked from the same page. 
 
Intel claim very significant increases in boot times and application speed. On a personal 
note, on my P4 2GHz, applications do start a lot faster. I suggest you do some 
benchmarking first (a stopwatch is an easy way to measure boot time). I would be 
interested in results people have had. This also works for 98SE,ME,NT4 and 2000. 

NOTE: IAA works well for most, but not all. Judge for youself. It's easy enough to uninstall if 
you don't like it. 

 
 
 
 
50 Its all about your priorities 
 
In life, the only way to succeed is to get your priorities straight. Well tough-luck, to all you 
slackers, the computer world ain't much different. Windows has setup a system controlled 
hiearchy which is notably called the Priority System. By increasing a programs priority, the 
task manager tells the system to pay more attention to it, by feeding it RAM and optimizing 
that program to use the system cache more effifiently. Lets explore into the wonderful world 
of priorities. 
 
1.) Right click on your taskbar and select TASK MANAGER 
2.) Under the Processes pane select a program that you would like sped up.  
3.) Now right click, and under Set Priority, set the system priority to High. 
 
That program will be much faster, and will run more efficiently. Beware, by setting it to 
Realtime requires a motherload of RAM (256MB a minimum). Note, the system priority 
won't always be high, it will only be high for the current session. Meaning, once you restart 
your computer, all your priorities will be set back to its default (most of the time normal). 
Another hint, is not to set a system priority, because system managed files will give you an 
Access Denied error. 
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Happy Tweaking!  
 
 
 
 
51 Launch apps with desired priority setting 

This tweak will launch most executables with the priority setting you want it to 
have.  

Let's say you have a game installed called HIGH NEEDS and the executable is called HN.exe  

Here's what to do: 

-Create a new textfile in the game-app wathever-directory (let's say C:\HN), but instead of 
giving it the .txt extension you name it  HN.bat 
-Right-click this file and choose 'Edit', you'll see it'll open notepad. Put this line in: 
cmd /c start /High HN.exe 
-Save (make sure you save it as .bat, not as .txt) and close. 

Now create a shortcut to this file and place it on your desktop. Every time you doubleclick 
this shortcut HIGH NEEDS will open with priority set to 'high'. (ofcourse you can also create 
a batchfile on your desktop, containing the full path of the app you want to start but the 
nice thing of creating a shortcut is you can give it an icon).  

These are all the settings: Realtime, High, AboveNormal, Normal, BelowNormal, Low. 

*Realtime is not recommended unless you have a dual-CPU system! 

 
 
 
 
52 Make icons in windows appear quicker 
 
In Windows XP everytime you open My Computer to browse folders XP automatically 
searches for network files and printers. This causes a delay in displaying your icons. You 
probably see the "default" windows icon and as you scroll it changes to the correct icon. 
This is how to stop that... 
 
1. Open My Computer 
2. Click on the Tools menu and select Folder Options... 
3. Under Folder Options select the view tab. 
4. Uncheck the very first box that reads "Automatically search for network folders and 
printers". 
5. Click "Apply" or "OK" 
 
You should see a dramatic increase in speed when Windows displays your icons.  
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53 Memory Performance Tweak 

These Settings will fine tune your systems memory 

management -at least 512MB of ram recommended 

go to start\run\regedit -and then to the following key 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management 

1.DisablePagingExecutive -double click it and in the decimal put a 1 - this allows XP to keep 
data in memory now instead of paging sections of ram to harddrive yeilds faster 
performance. 

2.LargeSystemCache- double click it and change the decimal to 1 -this allows XP Kernel to 
Run in memory improves system performance alot 

Reboot and watch your system fly ..happy tweakin 

Note: This tweak may cause problems with ATI cards *this is documented by ATI(tweak 
forum Admin) 

 
 
 
 
54 MFT Fragmentation 

After installing your XP/2000 PC with all software and data. Run at Cmd line like FOR /L %f 
in (1,1,10000) do md %f 

And then (not on root dir. C:\) FOR /L %f in (1,1,50000) do echo Hey > %f 

This will create 10000 dir and 50000 files that you can delete. This increases the MFT size. 
Download Diskkeeper demo. Run MFT defrag once and you will probaby never need it again 
:). 

Bye ;) 

 
 
 
55 Modify application timeout 
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The operating system has a set amount of time that a program must be frozen for before it 
is timed out.  Often this number is set too high, but in some circumstances it is set too low.  
If the program is doing a lot of calculations in the background the computer may think that 
it is timed out. To prevent this, increase the value of the timeout in the registry. 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  

2. Navigate to HKEY_CURRENT_USER\Control Panel\Desktop  
3. Select HungAppTimeout from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to the new timeout value.  
6. Reboot your computer. 

 
 
 
 
56 Modify application timeout 

The operating system has a set amount of time that a program must be frozen for before it 
is timed out.  Often this number is set too high.  But in some circumstances it is set too 
low.  Depending on if the program is doing a lot of calculations in the background the 
computer may think that it is timed out. To prevent this increase the value of the timeout in 
the registry. 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  

2. Navigate to HKEY_CURRENT_USER\Control Panel\Desktop  
3. Select HungAppTimeout from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to the new timeout value.  
6. Reboot your computer.  

 
 
 
57 Modify auto-reboot setting 

Since Microsoft has worked so hard to make this version "the most stable ever," then this 
tweak is not needed.  However, I am fairly sure that they have not perfected millions of 
lines of code in less than a year.  Below you will discover how to turn the auto reboot 
feature on and off.  This allows your computer to instantly reboot upon a system fault.  (The 
blue screen) 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  

2. Navigate to 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\CrashControl  

3. Select AutoReboot from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to 0 to disable and 1 to enable.  
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6. Reboot your computer.  

 
 
 
 
58 No DOZE 

If you don't plan to use the 'hibernate' function, and if you're running a desktop. You can 
reclaim a number of megabytes equal to your RAM on the hard drive: 

Go to the following......... 

*Control Panel  |  Power Options  |  Hibernate 

*Deselect 'Enable hibernation' and click OK. 

 
 
59 No more low disk space messages 
go into registry with REGEDIT.EXE, go to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\ 
and (if not already there) add DWORD (without quotes) "NoLowDiskSpaceChecks" and 
change the value to 1. Restart.  

 
 
 
60 NTFS Cluster size 

Cluster is an allocation unit. If you create file lets say 1 byte in size, at least one cluster 
should be allocated on FAT file system. On NTFS if file is small enough, it can be stored in 
MFT record itself without using additional clusters. When file grows beyond the cluster 
boundary, another cluster is allocated. It means that the bigger the cluster size, the more 
disk space is wasted, however, the performance is better. 

So if you have a large hard drive & dont mind wasteing some space, format it with a larger 
cluster size to gain added performance.  

The following table shows the default values that Windows NT/2000/XP uses for NTFS 
formatting:  

      Drive size                    
   (logical volume)             Cluster size          Sectors 
   ---------------------------------------------------------- 
     512 MB or less               512 bytes           1 
     513 MB - 1,024 MB (1 GB)   1,024 bytes (1 KB)    2 
   1,025 MB - 2,048 MB (2 GB)   2,048 bytes (2 KB)    4 
   2,049 MB and larger          4,096 bytes (4 KB)    8 
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However, when you format the partition manually, you can specify cluster size 512 bytes, 1 
KB, 2 KB, 4 KB, 8 KB, 16 KB, 32 KB, 64 KB in the format dialog box or as a parameter to 
the command line FORMAT utility.  

The performance comes thew the bursts from the hard drive. by having a larger cluster size 
you affectivly have a larger chunk of data sent to ram rather than having to read multiple 
smaller chunks of the same data. 

 
 
 
61 Open Outlook Express faster 

For some users when they remove windows messenger or just disable it from starting up 
automatically they experience a great slow down when launching Outlook express. Users 
who experience such a slow down will find a error in the system error log saying The 
server {FB7199AB-79BF-11D2-8D94-0000F875C541} did not register with DCOM 
within the required timeout.  

The solution to this problem is quite simple. Just Open up regedit and search for the string 
{FB7199AB-79BF-11D2-8D94-0000F875C541} and modify the keys InProcServer32 
and LocalServer32 default key to a empty string.  

 
 
62 Optimise NTFS 
 
NTFS is a great filesystem, but its feature-set comes at a slight cost in performance. You 
can negate this a little with the following tips: 
 
* By default NTFS will automatically update timestamps whenver a directory is traversed. 
This isn't a necessary feature, and it slows down large volumes. 
 
Disable it by pointing regedit to: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem and set 
'NtfsDisableLastAccessUpdate' to 1. 
 
* NTFS uses disparate master file control tables to store filesystem information about your 
drives. Over time these core MFT files grow and become fragmented, slowing down all 
accesses to the drive. By setting aside a little space, MFT's can grow without becoming 
fragmented. In the same key where you disabled the last access feature creat a new 
DWORD value called 'NtfsMftZoneReservation' and set it to 2. 
 
Note:  This tweak will not work on FAT32 file systems!  
 
 
 
 
63 Problems enabling DMA on IDE drives 
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Are you experiencing jerky DivX;-) movies or does your mp3s click and pop on your new fancy 
Pentium IV 3Ghz+? 
  
Then the reason is probably that XP has set your IDE drives into PIO mode instead of DMA! 
Remedy? Enter the device manager by right clicking “my computer” and choosing “properties” 
and then “hardware”. 
  
Double click on the “IDE primary drive” and then “advanced settings”. There you can see the 
current setting for the master and the slave drives on the primary IDE channel. There you can 
select transfer mode. If it is set at “PIO only”, then select “DMA if available” instead and reboot! 
  
If the computer persists on having only PIO after reboot even though the hard drive is a flashing 
super-duper ATA133 and transfer mode set to “DMA if available”, then you have to do the 
following: 
  
Remove the primary device in the device manager and reboot! Voilà, now the harddrive should 
be running in DMA mode. 
  
Repeat on the secondary IDE channel if necessary. 
  
Now enjoy your smooth running DivX;-) and mp3s and the overall increased performance of 
your computer! 

(Note: You will not see the Advanced Settings section if your hardware does not support it) 

 
 
 
 
64 Performance Increase through My Computer 
 
Easy enough tweak to usually find out about it on your own, but still, some of use still don't 
find it right away. So here it is:  
1: Start > Right Click on My Computer and select properties.  
2: Click on the "Advanced" tab  
3: See the "Perfomance" section? Click "Settings"  
4: Disable all or some of the following:  
 
Fade or slide menus into view  
Fade or slide ToolTips into view  
Fade out menu items after clicking  
Show Shadows under menus  
Slide open combo boxes  
Slide taskbar buttons  
Use a background image for each folder type  
Use common tasks in folders  
 
There, now Windows will still look nice and perform faster.  
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65 Reduce 10 second scandisk wait time 
Start MS Dos Prompt (Start run CMD) 
CHKNTFS/T:4 
where 4 is the amount of waity time 
 
CHKNTFS/?  
for more info  
 
 
 
66 Remove hibernation file 
If you do not use hibernation, make sure you do not have it enabled, which reserves disk 
space equal to your RAM. If you have a hidden file on the root directory of your C-drive 
called hiberfil.sys, hibernation is enabled. To remove that file, go to Control Panel, select 
Performance and Maintenance, Power Options, Hibernate tab, and uncheck the Enable 
hibernation box.  
 
 
 
 
67 Remove start-up items 

Having programs run when windows loads slows down your start. 
 
There are two ways do disable programs that may be in your startup (like icq, messanger,) 
 
The easiest is to do the following: 
1. start --> run --> msconfig 
2. Click on the "startup" tab (furthest right)\ 
3. Unclick any items you don't want to load when windows starts. 
 
The second is by deleting registry entrys, this can be done the following way: 
1. Start --> run --> regedit 
2. Navigate to : HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run 

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Run 
3. Delete any entry's that you don't want to load up 
 
***NOTE*** 
Deleting keys from the registry will not allow you to set them to startup again if you change your 
mind.  
********** 
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68 Sacrifice Graphics for Speed 

XP is very graphic-intensive which results in a large consumption of RAM. Sometimes to 
squeeze in the nitty-gritty megs of memory can be, by sacrificing the pretty little bits and 
colors that are on your screen. 
 
- For starters, reducing the color density and and bit display of your screen will ultimately 
increase speed to your computer.  
 
1.)On your desktop, right click and go to PROPERTIES. 
2.)In properties go to Settings, and set your color quality to the lowest bit-rating (most 
likely 15 bit). This will reduce color density, and icon quality, but will heavily boast system 
performance. 
 
- If you really want to increase your system performance, new Windows themes are NOT 
the way to go, if you are ill-equipped with RAM. 
 
1.) Go into Control Panel and into Performance and Maintenence (If you are using the 
"classic" view skip to step 2). 
2.) Get into System and click on the Advanced tab. 
3.) Now click on Performance 
4.) Under your visual effects, select CHOOSE BEST PERFORMANCE.  
5.) This will undoubtedly increase your system performance by returning XP into Classic 
Style and getting rid of the fancy-shmancy fading menus, shadows and whatnot.  
 
Now your graphically challenged computer, has turned into a mean, lean, computing 
machine. 
 
Happy Tweaking! 

 
 
69 Service Settings for Gamers 

Below is a list of windows services that we recommend you change to the manual setting. If 
you do not know how to do that, refer to our tweak on disabling windows services by 
clicking http://www.tweakxp.com/tweakxp/display.asp?id=34.  

Routing and Remote Access 
Alerter 
Application Layer Gateway Service** (only if firewll is not used) 
Application Management 
Background Intelligent Transfer Service 
ClipBook 
COM+ System Application 
Distributed Link Tracking Client 
Distributed Transaction Coordinator 
Help and Support 
IMAPI CD-Burning COM Service** (only if do you not use the cd-rw xp record suport) 
IPSEC Services 
Logical Disk Manager Administrative Service 
MS Software Shadow Copy Provider 
Net Logon 
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NetMeeting Remote Desktop Sharing 
Network DDE 
Network DDE DSDM 
Network Location Awareness (NLA) 
NT LM Security Support Provider 
Performance Logs and Alerts 
Portable Media Serial Number 
QoS RSVP 
Remote Desktop Help Session Manager 
Remote Procedure Call (RPC) Locator 
Remote Registry 
Removable StorageServer 
Smart Card 
Smart Card Helper 
SSDP Discovery Service 
System Restore Service 
Telnet 
Themes 
Uninterruptible Power Supply 
Universal Plug and Play Device Host 
Volume Shadow Copy 
Windows Image Acquisition (WIA) 
Windows Installer 
Windows Management Instrumentation Driver Extensions 
Wireless Zero Configuration 
WMI Performance Adapter 
Fast User Switching Compatibility ** (only if fast user shiching is not used or the machine 
have one user only) 
Protected Storage 
Windows Time 
TCP/IP NetBIOS Helper 
Task Scheduler 
Secondary Logon 
Print Spooler ** (only if the pc do not have or use a printer) 
Indexing Service 
Error Reporting Service 
Computer Browser 
Internet Connection Firewall (ICF) / Internet Connection Sharing  

 
 
70 Services 

Here are a list of MY Services and what they are set to, these settings may not work for 
everyone and they include some third party programs, but they might help you decide what 
you need and do not need. FYI - my setup is a stand alone pc using a cable modem. For a 
little more explanation of what the Services are look HERE . 
 
 
Name............................................Startup Type 
Alerter.........................................Disabled 
Application Layer Gateway Service...............Manual 
Application Management..........................Manual 
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Automatic Updates...............................Disabled  
Background Intelligent Transfer Service ........Disabled 
ClipBook........................................Manual  
COM+ Event System...............................Disabled 
COM+ System Application.........................Disabled 
Computer Browser................................Manual  
Cryptographic Services..........................Manual  
DHCP Client.....................................Automatic  
Distributed Link Tracking Client................Disabled  
Distributed Transaction Coordinator.............Disabled  
DNS Client......................................Automatic 
Error Reporting Service.........................Disabled  
Event Log.......................................Automatic  
Fast User Switching Compatibility...............Disabled  
Help and Support................................Disabled  
Human Interface Device Access...................Disabled  
IMAPI CD-Burning COM Service....................Disabled  
Indexing Service................................Disabled  
InteractiveLogon................................Disabled  
Internet Connection Firewall (ICF)/  
Internet Connection Sharing (ICS)...............Disabled  
IPSEC Services..................................Disabled  
Logical Disk Manager............................Disabled  
Logical Disk Manager Administrative Service.....Disabled  
Machine Debug Manager...........................Manual  
Messenger.......................................Disabled  
MS Software Shadow Copy Provider................Disabled  
Net Logon.......................................Manual  
NetMeeting Remote Desktop Sharing...............Disabled  
Network Connections.............................Manual  
Network DDE.....................................Disabled  
Network Location Awareness (NLA)................Manual  
NT LM Security Support Provider.................Disabled  
Performance Logs and Alerts.....................Disabled  
Plug and Play...................................Automatic  
Portable Media Serial Number....................Disabled  
Print Spooler...................................Automatic  
Protected Storage...............................Automatic  
QoS RSVP........................................Disabled  
Remote Access Auto Connection Manager...........Manual  
Remote Access Connection Manager................Manual  
Remote Desktop Help Session Manager.............Disabled  
Remote Procedure Call (RPC).....................Automatic  
Remote Procedure Call (RPC) Locator.............Manual  
Remote Registry.................................Disabled  
Removable Storage...............................Disabled  
Routing and Remote Access.......................Disabled  
Secondary Logon.................................Disabled  
Security Accounts Manager.......................Disabled  
Smart Card......................................Disabled  
Smart Card Helper...............................Disabled  
SSDP Discovery Service..........................Disabled  
System Event Notification.......................Disabled  
System Restore Service..........................Disabled  
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Task Scheduler..................................Automatic  
TCP/IP NetBIOS Helper...........................Disabled  
Telephony.......................................Manual  
Telnet..........................................Disabled  
Terminal Services...............................Disabled  
Themes..........................................Automatic  
Uninterpretable Power Supply....................Disabled  
Universal Plug and Play Device Host.............Disabled  
Upload Manager..................................Disabled 
Voulume Shadow Copy.............................Disabled  
WebClient.......................................Disabled  
Windows Audio...................................Automatic  
Windows Image Acquisition (WIA).................Automatic  
Windows Installer...............................Manual  
Windows Management Instrumentation..............Automatic 
Windows Management Instrumentation  
Driver Extensions...............................Manual  
Windows Time....................................Disabled  
Wireless Zero Configuration.....................Disabled  
WMI Performance Adapter.........................Disabled  
Workstation.....................................Disabled 
 

71 Services Info and Configurations 
 
Do you mean that out of 89 services, 36 are set to Automatic as DEFAULT, but, we MAY 
only need 5 running? In short, yes. 
 
More detail on XP Service decriptions and dependencies can be found at: 
 
http://www.blkviper.com/WinXP/service411.htm 
 
Suggested configurations for tuning internet gateway and gaming systems can be found at: 
 
http://www.blkviper.com/WinXP/servicecfg.htm  
 
 
 
72 Shutdown XP Faster 

1) Start - Run - Regedit 
Navigate to the following Registry key: 
HKEY CURRENT USER\Control Panel\Desktop 
Double click on the AutoEndTasks entry and replace the 0 with a 1 in the Value 
data text box 

For the next two, if the dword value indicated does not exist, create it: 

Double click on the WaitToKillAppTimeout entry in the right pane and change the 
Value data to 2000 
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Double click on the HungAppTimeout entry in the right pane and change the Value 
data to 1000 

Reboot 

If still having a problem, make the next change: 

2) HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control 
Right-click on WaitToKillServiceTimeout and change it to 2000 

NOTE: The lowest value Windows will recognize is 1000 (1 second) 

ADVISORY: While rare, the "WaitToKillService" tweak can cause problems. If an application 
is in the process of saving data and the associated service is stopped prematurely, the data 
will not be saved and may be lost. (Tweak, Note and Advisory from Forum Admin)  

 
 
 
 
73 Shutdown XP using your keyboard! 
 
Wouldn’t it be great to easily shut down or restart your computer with a simple keystroke? 
Well now you can! You know about “Ctrl, Alt, Delete”, but what about “Ctrl, Alt, END”? 
 
Here's how it's done. The instructions are quite simple, and as long as you follow along, this 
should be rather painless! Please follow step by step! 
 
1. Right click on your desktop. Go to new, and then click on shortcut. 
2. A window comes up. Type in “shutdown” (without quotes) add a space and enter one of 
the following commands: 
 
Usage: shutdown [-i | -l | -s | -r | -a] [-f] [-m \\computername] [-t xx] [-c "comment"] [-d 
up:xx:yy] 
 
-i Display GUI interface, must be the first option 
 
-l Log off (cannot be used with -m option) 
 
-s Shutdown the computer 
 
-r Shutdown and restart the computer 
 
-a Abort a system shutdown 
 
-m \\computername Remote computer to shutdown/restart/abort 
 
-t xx Set timeout for shutdown to xx seconds 
 
-c "comment" Shutdown comment (maximum of 127 characters) 
 
-f Forces running applications to close without warning 
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-d [u][p]:xx:yy The reason code for the shutdown 
u is the user code 
p is a planned shutdown code 
xx is the major reason code (positive integer less than 256) 
yy is the minor reason code (positive integer less than 65536) 
------------------------------------------ 
 
2. (Continuation) a good example of a shutdown line would read as follows: 
 
“shutdown -s -t 0” (of course, without the quotes) 
 
This tells the computer to run the shutdown program, and to shutdown the computer 
(marked by –s). The timer is set to zero, which will shut down the computer instantly 
(marked by –t 0) 
 
3. After you have created your customized shutdown command, click next. Enter a name for 
it and hit finish 
 
4. Right click on the shortcut you just created, and go to properties. 
 
5. Note where it says “Shortcut Key”. Enter your combination here. I recommend “Ctrl, Alt, 
END” as stated before, but the choice is purely up to you. 
 
6. Click OK. Your shutdown string is now effective! Just hit that key combination and your 
computer is off! 
 

 
 
 
74 Simple Outlook express loading after msn messenger is removed 
 
For those of you who have a slow-loading outlook express after msn messenger has been 
removed this may help. I tried the other tweaks stating this and i didn't have the registry 
settings that it said. So I looked at the options and found this: 
 
1. Open Outlook Express 
2. Click on tool, options 
3. Click on the general tab 
4. Uncheck "automatically log on to windows messenger" 
 
 
 
 
75 Skip Operating System selection on boot 

If you have more then one OS installed on your computer, but you don't use it very often, 
then you would probably want to boost up the startup by skiping the OS selection screen. 

First make sure your windows is set not to hide "protected oporating system files" (by going 
to Control Panel\Folder Options\View tab, and ucheck the "hide protected oporating system 
files" checkbox) 
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Edit the boot.ini file in your c: drive, so that the timeout value will be "0" (timeout=0) 

This will make your pc skip the os selection menu on startup. 

If you ever want to use your other os you can change the value back to what it was in the 
first place. 

 
 
76 Slow logon to domain in XP Pro 

You may experience extremely long delays (up to 5 minutes) when logging into domains 
using Windows XP Pro.  This is caused by the asyncronous loading of networking during the 
boot up process.  This speeds up the login process in a stand-alone workstation by allowing 
the user to log in with cached logon credentials before the network is fully ready. 

To disable this "feature" and restore your domain logons to their normal speed, open the 
MMC and add the group policy snap-in.  Under Computer Configuration-->Administrative 
Templates-->System-->Logon, change "Always wait for the network at computer startup 
and logon" to ENABLED. 

This can be fed to clients via a group policy from a Windows 2000 server by upgrading the 
standard policy template with the XP policy template.  Since this is an XP only command, 
non-XP systems will ignore it in a domain distributed group policy. 

 
 
 
77 Slow logon to domain in XP Pro 

You may experience extremely long delays (up to 5 minutes) when logging into domains 
using Windows XP Pro.  This is caused by the asyncronous loading of networking during the 
boot up process.  This speeds up the login process in a stand-alone workstation by allowing 
the user to log in with cached logon credentials before the network is fully ready. 

To disable this "feature" and restore your domain logons to their normal speed, open the 
MMC and add the group policy snap-in.  Under Computer Configuration-->Administrative 
Templates-->System-->Logon, change "Always wait for the network at computer startup 
and logon" to ENABLED. 

This can be fed to clients via a group policy from a Windows 2000 server by upgrading the 
standard policy template with the XP policy template.  Since this is an XP only command, 
non-XP systems will ignore it in a domain distributed group policy. 

 
 
 
78 Smooth Mouse 
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If you use a PS/2 mouse the following tweak will give you smoother mouse movement, 
which is also great for gaming. 

*Drill into Device Manager via Control Panel  |  System  |  Hardware  |  Device Manager and 
scroll to your mouse device. 

*Under Advanced Setting set the sample rate to 200. 

 
 
79 Speed Boot - Shave 2 Seconds 

I found that creating a script to run on shutdown that deletes the temp folder and history 
shaved 2.5 seconds on my boot time, down do 10.5 secs. 

Create a batch file by doing the following: 

1) Open notepad and enter the following lines: 

RD /S /q "C:\Documents and Settings\"UserName without quotes"\Local Settings\History"  
RD /S /q "C:\Documents and Settings\Default User\Local Settings\History"  
RD /S /q "D:\Temp\" <--"Deletes temp folder, type in the location of your temp folder" 

2) Save the fily and then rename is something like deltemp.bat 

3) Now click Start, Run and type in gpedit.msc --->Computer Configuration --->Windows 
Settings --->Scripts and double click on Shutdown --->Click Add and find the batch file you 
created and press ok to set the script 

 
 
 
80 Speed up boot by disabling unused ports 

What do you figure the chances of you ever using your computer's serial ports are? Exactly. 
The same with that parallel port. Disabling unneeded ports in your computer's BIOS can 
streamline the boot process and net you a little performance gain. Better still, no pain is 
involved. 

If you need the ports in the future, simply reactivate them in the BIOS. Look in the 
'integrated peripherals’ section of the BIOS to find your ports and disable them. 

 
 
 
81 Speed up Detailed view in Explorer 
 
If you like to view your files in Windows Explorer using the "Details" view here is a tweak to 
speed up the listing of file attributes: 
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Viewing files in Windows Explorer using the "Details" mode shows various attributes 
associated with each file shown. Some of these must be retrieved from the individual files 
when you click on the directory for viewing. For a directory with numerous and relatively 
large files (such as a folder in which one stores media, eg: *.mp3's, *.avi's etc.) Windows 
Explorer lags as it reads through each one. Here's how to disable viewing of unwanted 
attributes and speed up file browsing: 
 
1. Open Windows Explorer 
2. Navigate to the folder which you wish to optimize. 
3. In "Details" mode right click the bar at the top which displays the names of the attribute 
columns.  
4. Uncheck any that are unwanted/unneeded. 
 
Explorer will apply your preferences immediately, and longs lists of unnecessary attributes 
will not be displayed. 
Likewise, one may choose to display any information which is regarded as needed, getting 
more out of Explorer. 
 
 
 
 
82 Speed up Menu Appearance Without Causing Problems with                         
zero delay 

This is a response to all the people that have posted this tweak. Follow these steps to avoid 
menus popping up too fast when opening up the start menu or any other menu, making it 
less annoying because un-wanted menus won't pop up first. 

1. Start Regedit.  (Click on Run in the start menu, then type "regedit" without the 
quotes and hit enter)  

2. Navigate to HKEY_CURRENT_USER\Control Panel\Desktop  
3. Select MenuShowDelay from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to only 150, its the perfect speed setting so menus appear quick, 

but not to quick so that the un-wanted ones appear.  
6. Reboot your computer.  

This little toggle will amke a big difference and cause less agony. :-) 

 
 
 
83 Speed up menu display 

When using the start menu you will notice a delay between different tiers of the menu 
hierarchy.  For the fastest computer experience possible I recommend changing this value 
to zero.  This will allow the different tiers to appear instantly. 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  
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2. Navigate to HKEY_CURRENT_USER\Control Panel\Desktop  
3. Select MenuShowDelay from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to something lower (note: a setting of zero (0) is virtually instantaneous - 

experiment with other settings (200 or 300 or 400 perhaps) to see what you are most comfortable 
with..  

6. Reboot your computer. 

 
 
 
84 Speed up menu display 

When using the start menu you will notice a delay between different tiers of the menu 
hierarchy.  For the fastest computer experience possible I recommend changing this value 
to zero.  This will allow the different tiers to appear instantly. 

1. Start Regedit.  If you are unfamiliar with regedit please refer to our FAQ on how to 
get started.  

2. Navigate to HKEY_CURRENT_USER\Control Panel\Desktop  
3. Select MenuShowDelay from the list on the right.  
4. Right on it and select Modify.  
5. Change the value to 0  
6. Reboot your computer. 

Note from forum Admin - a setting of zero (0) is virtually instantaneous - experiment with other settings 
(200 or 300 or 400 perhaps) to see what you are most comfortable with 

 
 
 
 
85 Speed up Network Browsing 
 
There was a bug in windows 2000 that would cause the scheduled tasks folder to be 
searched when ever the user would browse network drives. Microsoft developed a fix for 
this bug. The fix fixed the problem and it also had nice side affect of speeding up browsing 
of Microsoft networks. Below are instructions how to apply the fix. 
 
1. Open up regedit.  
2. Navigate to HKEY_LOCAL_MACHINE/Software/Microsoft/Windows/Current 
Version/Explorer/RemoteComputer/NameSpace.  
3. Find a key named {D6277990-4C6A-11CF-8D87-00AA0060F5BF}.  
4. Right click on it and delete it.  
5. Restart  
 
 
 
86 Speed-up log-in tremendously! 
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If you've tried everything and your log-in and log-off to XP is still slow then you might try 
this little trick. First, if there are any other users on your computer see if they have a 
similarly long log-in. If they don't the problem might be your roaming profile, which is a 
folder where XP stores your settings you can access them from anywhere in the network. 
Since these profiles can get really bloated(as in my case) and are not really necessary 
unless you log-in from different computers in a large network, you should disable it. Here's 
how:  

1. Right click on My Computer, select the Manage option.  

2. From the Management Console, select the Local Users and Groups option.  

3. Double-Click on the Users folder that appears on the right panel.  

4. Right click on the account with the slow log-in and select Properties.  

5. Click on the Profile tab of the Properties Window.  

6. Erase (but keep note a not of this) whatever path appears for Profile Path under User 
Profile and Local Path under Home Folder: LEAVE THESE LINES BLANK.  

7. Reboot. Try to log-in into the problematic account, you should see a significant speed-
boost, the computer might warn you once or twice that your Roaming Profile is not 
available, ignore it and it will go away, good luck! 

Note:  You also will not have your settings and files that a roaming profile provides across a 
network.   

 
 
 
 
87 Stop Jerkey Graphics 
 
I have for a long time had problems with "jerky" graphics in some 3d games and 3dmark, 
and have had relativly high cpu loads in idle condition. 
The cpu load would pulse from 1-2% up to 10-12%-load with about three-five seconds 
intervals...(in idle) 
The jerking has not been due to low perfomance hardware or old drivers and I have had the 
problems on two seperate systems. 
If you are connected to a LAN and have similar problems, this might be the solution: 
 
1.RightClick "MyComputer" 
2.Select "Manage" 
3.Click on "Device Manager" 
4.DoubleClick on your NIC under "Network Adapters" 
5.In the new window, select the "Advanced" tab 
6.Select "Connection Type" and manuelly set the value of your NIC. (Not "Auto Sense" 
which is default.)  
7.You should reboot... 
On my systems the "jerking" in 3D games was completly gone, and so was the high idle cpu 
load.  
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This tip also applies to Win2K.  
 
 
 
 
88 Stop jerky graphics. The alternative way. 
 
Since I started using XP, I noticed that games performance was terrible. Idle CP load stayed 
at around 12% all the time. This lead to jerky graphics, choppy sound, every game I tried 
was the same, even DVD playback suffered. I tried the tweak  
http://www.tweakxp.com/tweakxp/display.asp?id=822 
but I didn't see any difference. If you also experience this problem and have a Zip drive, 
here's how I solved it. 
 
1.Right click "My Computer" 
2.Select "Manage" 
3.Click on "Device Manager" 
4.Double click on your Zip under "Disk Drives" ( it may be listed as "IMG VP01" or 
something similar - pick the one that's not a hard drive) 
5.Disable the device 
 
If you then need to use the Zip drive, simply re-enable it by following similar steps. 
 
This worked fine for me, XP is now as fast as 98 (well, almost!).  
 
 
 
 
89 Stripping Page File across Multiple Hard drives 

This is an incredible tweak that has improved the performance of my system by leaps and 
bounds. 

There have been lots of articles and tweaks concerning the Page File. I have tried them all, 
however, whilst researching articles for work, I came across this tweak directly from 
Microsoft that has been the best improver of my system performance. 

If you have two or more hard drives, especially if they reside on separate IDE channels, it is 
possible to Strip the Page File across these two drives. Windows XP has code within it that 
will enable a RAID-Type Stripping. Therefore, Windows XP will through its internal 
algorithms place information in the separate drives. By accessing both of the Drives at the 
same time to read/write information, Windows XP will considerably improve its 
performance! 

Simply go to System Properties > Advanced > Performance > Settings > Virtual Memory 
and assign the page file a size on each drive. 

The way I did mine is as follows: 
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I have two hard drives each formatted with two partitions each. Hence I have a total of 4 
Partitions being displayed. On my secondary HD, I created the first Partition and called it my 
SWAP. Since I have 512 MB of RAM, I created the partition with 1.5 GB. On this partition, I 
assigned the Swap File of 764 - 1500 MB. On the Primary Partition which Contains my 
Operating System, I also have a swap file of the same 764-1500 MB. 

Try this out my friends. I guarantee you will be impressed with the results. As a 
comparison, when I had a single partition, one application used to suck 100% of my cpu 
cycles and my swap file usage jumped way high. Ever since I started the page file stripping, 
that very same application sucks only 5% CPU cycles! 

 
 
 
 
90 System Settings for a Game Machine 
 
If you are a hard core gamer then the below tweak is for you. Below is a list of windows 
services that we recommend you change to the manual setting. If you do not know how to 
do that, refer to our tweak on disabling windows services by clicking here.  
 
 
Routing and Remote Access 
Alerter 
Application Layer Gateway Service** (only if firewll is not used) 
Application Management 
Background Intelligent Transfer Service 
ClipBook 
COM+ System Application 
Distributed Link Tracking Client 
Distributed Transaction Coordinator 
Help and Support 
IMAPI CD-Burning COM Service** (only if do you not use the cd-rw xp record suport) 
IPSEC Services 
Logical Disk Manager Administrative Service 
MS Software Shadow Copy Provider 
Net Logon 
NetMeeting Remote Desktop Sharing 
Network DDE 
Network DDE DSDM 
Network Location Awareness (NLA) 
NT LM Security Support Provider 
Performance Logs and Alerts 
Portable Media Serial Number 
QoS RSVP 
Remote Desktop Help Session Manager 
Remote Procedure Call (RPC) Locator 
Remote Registry 
Removable Storage 
Server 
Smart Card 
Smart Card Helper 
SSDP Discovery Service 
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System Restore Service 
Telnet 
Themes 
Uninterruptible Power Supply 
Universal Plug and Play Device Host 
Volume Shadow Copy 
Windows Image Acquisition (WIA) 
Windows Installer 
Windows Management Instrumentation Driver Extensions 
Wireless Zero Configuration 
WMI Performance Adapter 
Fast User Switching Compatibility ** (only if fast user shiching is not used or the machine 
have one user only) 
Protected Storage 
Windows Time 
TCP/IP NetBIOS Helper 
Task Scheduler 
Secondary Logon 
Print Spooler ** (only if the pc do not have or use a printer) 
Indexing Service 
Error Reporting Service 
Computer Browser 
Internet Connection Firewall (ICF) / Internet Connection Sharing (ICS) 
 
Have Fun!  
 
 
 
 
91 The System Configuration Utility 
 
A Handy utility for speeding up system performance in Windows XP (or any version of 
Win9x/me for that matter as well) is the System Configuration Utility. To access the system 
configuration utility, go to Start and click Run. Type msconfig and click ok. Click the tab 
labeled Startup. Uncheck any items for which you do not care if they load when Windows 
loads or you do not have any idea what they are. In Windows XP, no items that are listed 
here are essential to Windows running properly, so feel free to experiment. After you 
removed everything you don't need, click apply and then ok. Say yes when it asks you to 
restart your system. Enjoy the significantly enhanced performance!  
 
 
 
 
92 Turn off disk performance monitors 

In Windows 2000 and XP Performance Monitor disk counters for physical disks are turned on 
by default, disk counters for logical disks are turned off by default. 

You can disable all disk monitoring by running this command 

DISKPERF -N 
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To turn it on again run this command 

DISKPERF -YD 

 
all DISKPERF switches: 
   -Y  Sets the system to start all disk performance counters 
       when you restart the computer. 
   -YD Enables the disk performance counters for physical drives when you  
       restart the computer. 
   -YV Enables the disk performance counters for logical drives 
       or storage volumes when you restart the computer. 
   -N  Sets the system to disable all disk performance counters when you  
       restart the computer. 
   -ND Disables the disk performance counters for physical drives. 
   -NV Disables the disk performance counters for logical drives. 

 
 
 
93 Turn off Indexing to speed up XP 

Windows XP keeps a record of all files on the hard disk so when you do a search on the hard 
drive it is faster. There is a downside to this and because the computer has to index all files, 
it will slow down normal file commands like open, close, etc. If you do not do a whole lot of 
searches on your hard drive then I suggest turnning this feature off: 
 
1. Control Panel 
2. Administrative Tools 
3. Services 
4. Disable Indexing Services 

 
 
 
94 Turn off System Restore to save space 
 
By default, Windows XP keeps a backup of system files in the System Volume Information 
folder. This can eat up valuable space on your hard drive. If you don't want Windows to 
back up your system files: 
 
1. Open the Control Panel 
2. Double-click on system 
3. Click the System Restore tab 
4. Check "Turn off System Restore on all drives" 
5. Hit Apply 
6. You may now delete the System Volume Information folder. 
 
Warning! If you turn this off you will not be able to use Windows System Restore to restore 
your system in case of failure.  
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95 Unload .dll's to Free Memory 
 
Windows Explorer caches DLLs (Dynamic-Link Libraries) in memory for a period of time 
after the application using them has been closed. This can be an inefficient use of memory.  
 
1. Find the key 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer].  
2. Create a new sub-key named 'AlwaysUnloadDLL' and set the default value to equal '1' to 
disable Windows caching the DLL in memory.  
3. Restart Windows for the change to take effect.  
 
 
 
 
96 Users not interested in fancy windows and colors 
 
It’s understood that most computer users decide they want fancy desktops windows, cool 
fades and colors. But if you’ve changed your mind and want better performance try this! 
 
1. Right click "My Computer" and choose properties. 
 
2. Click on the advanced tab, and than performance settings. 
 
3. You now are now in the visual effects tab, check adjust for best performance, and 
uncheck every squared box you see starting from "Animate windows when minimizing and 
maximizing, all the way down. 
 
4. Click OK, OK, and restart computer to see the difference in speed. 
 
 
 
 
97 Very Slow boot when networking 
 
On some XP Pro installations, when connected to a network (peer-peer in this case), the 
computer boot time is over 1:40. The system seems to freeze after logging in and the 
desktop may not appear or will freeze for a minute. As timed with the utility, Bootvis.exe, 
the problem was with the driver mrxsmb.dll, adding over 67 seconds to the boot time. 
Turning off and restoring file and printer sharing eliminated 65 seconds from the boot time. 
 
1. Alt-click (or right click) on Network Places > Properties 
2. Alt-click on Ethernet Adapter connection > properties 
3. Un-check "File and Printer Sharing for Microsoft Networks" > OK 
4. reboot 
5. If you need file or printer sharing, repeat the above, re-check the box and re-boot again. 
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98 View and manage startup programs 
 
Type msconfig in Start / Run and then go to the startup tab. Here you can select which 
programs you want to enable and which you want to be disabled from starting up.  
 
 
 
 
99 View XP System Uptime 

To view the amount of time that XP has been running with out rebooting or restarting the 
computer: 

1) Open the Command Prompt (located under Accessories) 

2) Type 'systeminfo' (without the dashes) 

3) Once the system has finished gathering the information, scroll up and the time is 
displayed in the System Up Time field. 

As you can see, running systeminfo also gives a lot of useful information. 

 
 
 
100 Watch movies with 'AboveNormal' priority  

 
This tweak will launch WindowsMediaPlayer with the 'AboveNormal' priority 
setting when opening a mediafile. 

Having trouble watching a movie when you also have a lot of background processes going 
on?  

Here's what to do: 

1. Create a new textfile in the root of c:\, but instead of giving it the .txt extension you 
name it  wmp_AboveNormal.bat 

2. Right-click this file and choose 'Edit', you'll see it'll open notepad. Put this line in: 
start /AboveNormal C:\"Program Files"\"Windows Media Player"\wmplayer.exe 
%1 %* 

3. Save (make sure you save it as .bat, not as .txt) and close. 

Now all you have to do is register your mediafiles to this batchfile. Here's how to do that: 
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4. In Windows Explorer choose Tools>Folder Options >File Types 

5. Scroll down(press A) to the AVI filetype 

6. Click 'Change' and point to c:\wmp_AboveNormal.bat . Click OK and Close. 

Now everytime you dubbleclick an .avi WMP will open with the 'AboveNormal' -priority 
setting !  (Repeat steps 4-6 to register all mediatypes you want to be opened this way.) 

  

These are all the settings: Realtime, High, AboveNormal, Normal, BelowNormal, Low. 

*Realtime is not recommended unless you have a dual-CPU system! 

 
 
 
101 Windows XP does have a back-up Utility!!! 
 
Insert your windows XP disc into your PC. Click exit if your installation screen comes up. 
Now go too your CD drive in *My Computer*. Right-click and select open. Choose VALUE 
ADD\MSFT\NT BACK-UP FILE. In the *files of type* drop down list be sure that *select all 
files* is on. Click on the NTBACK-UP.msi file and click okay. Click the finish button and now 
go over too the start button\ALL PROGRAMS\ACCESSORIES\SYSTEM TOOLS\ and there it is 
now.. BACK-UP FILES...Great little tool that Microsoft never should have hidden.  
 
 
 
 
102 Windows XP Icon Cache 
 
Are you experiencing icon lag, while browsing thru all your Start icons and programs? Do 
you have a smaller menu delay and your icons need ages to load? No need to give up. 
 
Just refresh the icon cache by deleting the IconCache.db file from your profile directory 
(usually /Documents and Settings/Username/Local Settings/Application Data). It will be 
automatically recreated. 
 
Also this tweak will speed up the icons even more: 
http://www.tweakxp.com/tweakxp/display.asp?id=905  
 

 
 

103 Obtain the newest drivers for your hardware  

This may seem a bit obvious, but keeping your system's drivers up to date can give both 
your performance and stability a boost. Video card manufacturers release updates especially 
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often, and these can often give "significant boosts" to gaming performance as video card in 
question is "optimized."  

Don't neglect the other components of your system either. Your motherboard manufacturer 
may have released newer versions of its Input/output drivers for your board, and sound 
cards and other peripherals can also benefit from newer software. 

 
 

104 Backing up and editing the registry  

Several of the performance tweaks in this guide require you to edit the Windows registry, 
which can be extremely hazardous to the health of your operating system unless it is done 
carefully. Editing the registry opens up a world of possibilities for tweaking WindowsXP that 
would otherwise be unavailable, but it also offers you the ability to completely mess up your 
system in the time it takes to reboot... 

For this reason, we strongly recommend that you back up your registry to a file before 
attempting any of the registry-related tips in this guide.  

To back up the entire registry, open REGEDIT and ensure that 'my computer' is highlighted, 
then go to file\export.  

In this window, you need to enter a location to save the exported registry (as a single file) 
and choose the type of file to create. Also, check the 'all' button at the bottom of the screen 

to backup the entire registry.  

There are several possible file types, but we will focus on one only, as the ".reg" file type is 
the easiest to use. A .reg backup will copy over all changes made to existing portions of the 
registry when it is restored, while leaving additions to the registry made since the backup 
untouched.  
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Select the .reg file type and click 'save.' 

Restoring the registry from this .reg file is a simple matter of locating the file you created, 
right clicking it and selecting 'merge.'  

The REGEDIT program which can be accessed from the run command ('start\run') by 
typing 'regedit'.  

 
 

105 Creating a system restore point  

One of Windows XP's brand new features is the System Restore utility, an update of the 
registry rollback tool first seen in Windows ME. The program has been considerably 
enhanced since these humble beginnings, and is a very useful safety tool. It uses 'restore 
points' which are snapshots of your registry and system condition at a specific time. The 
points are stored on disk and can be used to effectively move your PC back through time to 
a previous condition.  

As you can imagine, this utility comes in quite handy for heavy-duty tweaking (though it 
wastes a LOT of disk space by default, more on this later), acting as a safety net.  

To create a restore point: 
Go to 'start/all programs/accessories/system tools/system restore.' 
Click 'create a restore point.' 
Give your restore point a name and click 'ok.'  

That's all. To restore your system to its previous condition, fire up system restore again and 
select 'restore my system to an earlier time.' You will be presented with a calendar view of 
all current restore points. Windows creates them automatically by default under certain 
conditions such as program installs. Choose the one you created, click 'next' and follow the 
instructions.  

 
 

106 Saving your hard drive space from  
      the system restore utility  

By default, Windows XP's system restore utility uses a mammoth 12% of each hard drive in 
your system. That's a lot of wasted space. By reducing this number, you reduce the amount 
of restore points system restore can create, but this does not adversely affect the 
functionality of the program. System restore will delete older restore points to make room 
for newer ones.  

To decrease the amount of space system restore uses:  

Right click on 'my computer' and select 'properties' then the 'system restore' tab.  
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The window below contains each of the hard disks installed on your system. Highlight each 
one in turn and press the 'settings' key.  

 

Move the slider to adjust the amount of drive space used. I would recommend no more than 
2-4% of each drive. 

 
 

107 Editing registry settings without restarting  

Once you have made a change to the registry in Windows XP, you generally have to reboot 
the computer in order for your change to take effect. This is not actually necessary, as with 
a simple set of commands, you can cause the system to reload the registry by stopping and 
restarting the 'Explorer' process.  

To do this:  

Save and close all open files you might be working on. For example, if you are writing a 
document, you'll need to close this before reloading the registry.  

Press CTRL+ALT+DEL to bring up the task manager.  

In the 'processes' tab, highlight 'explorer.exe' and click 'end process.' All windows and 
desktop icons will disappear except for task manager.  

Now go to the 'file' menu in task manager and select 'new task (run…).' Type 'explorer' into 
the text box. This will relaunch explorer and load your new registry settings without 
restarting.  

 
 

108 Accessing & Updating your BIOS 

Getting access to your BIOS is done when you first start booting your computer.  You keep 
tapping one of the function keys while it’s booting.  Which one depends on your computer 
but usually it’s one of the following:  DEL (Dells), F1 (IBM, HP, Gateway), F2, ESC etc.  
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Often the key to press will be displayed for a short period of time when you first turn the 
computer on. 

In order to ensure that you get the maximum performance and stability out of your system, 
it's a good idea to make sure that you are using the latest version of your motherboard's 
BIOS. 

Motherboard manufacturers periodically release updated BIOS versions for their products, 
which are designed to be written over the older software. Traditionally, the process of BIOS 
'flashing' involved using a bootable floppy to start the computer in DOS, then using the 
motherboard companies BIOS programming software in combination with the newest BIOS 
version that you had acquired to update the motherboard. 

Most manufacturers now offer more user friendly BIOS updating methods, some working 
within Windows itself. Check the website of your motherboard manufacturer for updated 
BIOS versions and the software to install them, which will include instructions. 

The current version number of your motherboard is available both on the POST screen and 
within the BIOS settings screen. 

 
 

109 Overclocking your processor and memory 

Caution! While overclocking your memory, processor and video card can and probably will 
net you more performance gains than any other tip in this article, the process of 
overclocking also generally voids the warranty of most of your computer hardware. Actual 
damage to your components is also possible, though rather unlikely if you are careful. 
Please be careful. We take no responsibility for any damage incurred while following these 
directions. 

 Overclocking the memory/front side bus  

The Front Side Bus (FSB) is the data channel used to carry information between the 
processor and the main memory. Generally this runs at the speed of the memory itself, 
though some newer chipsets allow the memory to run faster than the actual speed of the 
FSB. Since almost all data dealt with by your computer is passed over this link, increasing 
the speed of the FSB by overclocking it is the single best way to increase the performance 
of your PC.  

Overclocking the FSB stresses both the processor and the memory, since both are forced to 
work faster.  

The rated speed of the processor (in MHz or GHz) is derived from the speed of the front side 
bus x the CPU multiplier, which multiplies the FSB speed to arrive at the internal speed of 
the processor (the amount of operations it can perform in a second).  

For example, a recent AMD Athlon XP 2800+ processor uses a 166MHz FSB speed (which is 
actually 333MHz with DDR memory, but this is not taken into account when calculating the 
processor speed). The AthlonXP 2800+ has a multiplier of 13, so that works out to 12.5 X 
166MHz which equals roughly 2.075GHz. 
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So you can see, as the FSB increases, so does the speed of the processor.  
FSB overclocking also increases memory bandwidth (the amount of data that can be carried 
at one time between the processor and the memory) and this has a huge impact on 
performance in some applications.  

To overclock the FSB:  

First benchmark your system with one of the 'whole system' benchmarks listed above, or 
one of the 3D gaming benchmarks listed in the 'video' section of this guide. It's good to 
know where your system stands before you go about overclocking. That way, you'll have an 
idea of what kind of advantage the tweak has brought you and your system.  

Find the memory/FSB frequency setting (generally found within the 'frequency\voltage 
control' section of the BIOS) and begin increasing the speed in small increments (3-10Mhz). 
Save and reboot after each change. If your PC boots successfully, run the benchmark(s) 
again and compare the numbers.  

Repeat the process until the system fails to boot into Windows successfully. Retry once to 
be sure, then boot back into the BIOS and change to the previous highest setting. By 
running the benchmark each time, you are also testing to see how stable the overclocked 
system is; so if the benchmark crashes, chances are you've pushed your PC too far to run 
reliably.  

 
 

110 Move the page file from system drive  

The page file is the area of a hard drive which Windows reserves for use as virtual memory 
when there is more data than can be stored in the actual physical memory of the system. 

Page file access is extremely slow as compared to standard memory, since the hard disk, as 
a mechanical device, is slower to read and write information than the purely electronic 
memory. There are still some ways to optimize your page file use so it is a bit less of a 
burden on your system, however. 

One of the best of these methods, provided you have two physical hard drives, is to move 
the page file off the disk which hosts the Windows system files. This ensures that Windows 
is not constantly accessing the disk for the system files as well as the page file. 

To do this in Windows XP:  

Right click on 'my computer' and select 'properties.' 

Select the 'advanced' tab. 

Under 'performance' choose the 'settings' button. 

Select the 'advanced' tab again and under 'virtual memory' select 'change.' 
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The virtual memory window allows you to select and change the allocation of hard disk 
space to be used as virtual memory for your system. For best performance; if you have two 
physical hard disks of roughly equivalent speed, remove the page file from your system disk 
(c:) and place it on the other drive.  

 
 

111 Create a 'permanent' page file  

Make the minimum size of the page file the same as the maximum size. This saves the 
operating system from needing to resize the page file, and does not lose you any extra 
space, since the 'maximum' size the page file can reach is the amount of hard disk space 
that is reserved by the OS.  

Right click on 'my computer' and select 'properties.' 

Select the 'advanced' tab. 

Under 'performance' choose the 'settings' button. 

Select the 'advanced' tab again and under 'virtual memory' select 'change.' 

Highlight the drive containing your page file and make the 'initial size' of the file the same 
as the 'maximum size' of the file.  
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112 Optimize your page file size  

Windows XP sizes the page file to about 1.5X the amount of actual physical memory by 
default. While this is good for systems with smaller amounts of memory (under 512MB) it is 
unlikely that a typical XP desktop system will ever need 1.5 X 512MB or more of virtual 
memory. As a simplified guideline. If you have less than 512MB of memory, leave the page 
file at its default size. If you have 512MB or more, change the ratio to 1:1 page file size to 
physical memory size.  

See Tip 110 to access the Virtual Memory setting page. 

 
 

113 Check your hard drives for errors with “Chkdsk” 

With time and heavy use, a myriad of data problems and physical problems can develop and 
mar the performance of your hard drive, not to mention cost you precious space. While 
defragmenting the drive can help restore much of the performance you might have lost, 
there are other issues such as lost clusters and bad sectors which the defragmentation 
utility cannot touch.  

Because of this, it is a good idea to run XP's built in error checking utility on your drives 
once in a while. This utility will scan your disks for errors and optionally attempt to correct 
them.  

Open 'my computer.' 

Right click the hard disk you wish to check and select 'properties.' 

Choose the 'tools' tab and under 'error checking' select the 'check now…' button. 

Check both options. You will need to restart the computer to do the full disk check. 

Your disk will be fully checked for errors upon reboot, but be aware that this can take quite a 
while. 

 
 

114 Force XP to unload DLL files after closing a program 

Dynamic Link Libraries, or DLLs, are files containing data or functions that Windows 
programs can call when needed by linking to them. Every piece of windows software will 
include instructions to the operating system as to which DLLs it will need to access, and XP 
will cache these particular files in memory for faster access.  
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The trouble is, Windows XP keeps these DLLs cached after the relevant program has closed, 
wasting memory space. While DLLs are generally tiny, enough of them can make a dent, so 
it's worthwhile to implement this registry tweak, which will force Windows XP to unload DLLs 
used by a specific program when that program halts.  

To do this, first run REGEDIT. 

Navigate to 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer.  

Create a new key named 'AlwaysUnloadDLL' and set the default value to equal '1.' 

 
 

115 Thaw out your desktop 

Every version of Windows has suffered from occasional 'desktop freezing.' You know the 
symptoms... You tell Windows to do something it doesn't like and everything except your 
mouse pointer slows to a c-r-a-w-l. You can open the start menu but applications won't load 
or close. Very frustrating.  

Fortunately there can be a cure for desktop freeze, at least in Windows 2000 and XP, and 
it's an easy one. First, save any data you are working on, the press CRTL + ALT + DEL to 
bring up the task manager. 

Select the 'processes' tab and highlight 'explorer.exe' then click 'end process'. 
Without exiting from task manager, click 'file\New Task' and type 'explorer.exe.' 
You should find that your computer has thawed itself out again. 

 
 

116 Change to the NTFS file system 

If you are using Windows XP, it's a good idea to convert your system drive to the NTFS file 
system if you have not already. In addition to providing numerous security and data 
recovery improvements over FAT32 (the file system of choice for Windows 9x/ME and XP 
Home) it can also speed up your system slightly.  

In fact, the only real reason for sticking with the FAT32 file system for any of your data is if 
you have more than one operating system on your PC and the other OS's can only see 
FAT32 partitions (as would be the case with Windows 98, for example, which is incapable of 
reading NTFS data).  

To convert your drives to NTFS: 

Right click on 'my computer' and select 'manage' 

From the computer management window, expand storage and select 'disk management.' 
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Using the 'file system' column of the upper pane of this window, you can easily check what 
file system each of your logical drives is using. Make a note of this information. 

Now open a command prompt window by going to 'start\run' and typing 'cmd' 

To convert a disk to NTFS, type 'convert (drive letter): /fs:ntfs' 

So for example, if you were going to convert your C: drive, you would type 'Convert c: 
/fs:ntfs' at the prompt.  

 
 

117 Reduce recycling bin reserved space 

By default, Windows XP reserves 10 percent of each hard drive to store deleted files in the 
recycling bin. This is a bit excessive. Actually it's a lot excessive, unless you habitually 
delete files a gigabyte in size or more. Fortunately, there is an easy way to reduce the 
amount of hard disk space that is reserved for the recycling bins on each drive.  

Right click on the recycling bin and select 'properties.' 

Choose the 'global' tab. 

The slider shows the percentage of each drive that is reserved by the recycling bin. Reduce 
this to a more appropriate amount, like 2-3% or more depending on the size of your drives. 
The larger the drives, the smaller the number you should use. If you wish to configure each 
drive independently, check the 'configure drives independently' button and adjust the slider 
to the desired amount in each of your hard disk's tabs. The advantage to doing things this 
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way instead of using the 'global' setting is that you can see the actual amount of space on 
each drive that is being reserved.  

Note that files larger than the recycling bin's capacity on a given drive are deleted for good. 
Windows XP will warn you when this condition occurs. 

 
 

118 Enable write caching on hard disks 

If it is not already selected, enabling the hard drive write-back cache setting on each of your 
hard drives can improve their performance by making the transferring of data between the 
drive and the memory more efficient. The only reasons not to enable this setting would be if 
the drive in question is in a hot-swappable drive rack, or if you expect your PC to be shut 
down incorrectly (I.E. not through the windows shutdown procedure) often. 

To enable write caching right click on my computer and select 'properties.' 

Select the hardware tab, then 'device manager.' From the device manager window, expand 
'disk drives' and highlight your hard disk. Select 'properties' then the 'policies' tab. 

 

Check the 'enable write caching on the disk' box. 

Repeat the above steps for all hard drives in your system. 

 
 

119 Defragment your hard disk(s) 
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When an operating system writes data onto a hard drive, it will generally attempt to place 
the data on the drive as sequentially as possible, in order to facilitate faster retrieval of the 
information. Over the operational life of the drive, various factors can cause data to become 
scattered, or fragmented, over the surface of the drive.  

This does not mean it cannot be read, since the file system retains a table which links each 
cluster (the smallest unit of storage available on a hard drive) of data with the other 
clusters on the disk that contain data for a particular file.  

Fragmentation does slow down drive access considerably though, since the drive has to 
constantly seek for a new disk location to piece a file it is reading together from the 
fragmented clusters, rather than just being able to grab it off the disk in one continuous 
stream of data. Factors that can cause fragmentation include incomplete uninstalls of 
software, system crashes while the disk is in use, improper shutdown of the operating 
system, etc.  

Defragmentation is the process of reassembling the data on the disk into coherent and 
sequential order, making disk access easier and faster. If your drive has gone a long while 
without being defragmented, you may find that this process restores a lot of zip to your 
Windows install. All recent versions of Windows include a built-in defragmentation utility.  

To access this utility in Windows XP, go to 'start\programs\accessories\system tools\disk 
defragmenter.'  

To begin with, you need to analyze your hard disk(s) to see if defragmentation is needed. 
Select a drive and hit the 'analyze' button. This could take a little while depending on the 
amount of data on the drive. 

Once the analysis is finished, you will have a graphical representation of your disk's level of 
fragmentation. See the pic below for an example of a highly fragmented drive (red indicates 
fragmented files). 

 

Windows will also inform you if it recommends defragmenting the drive. You must have 
15% of the drive free in order to fully defragment it. Anything less will result in only a 
partial re-ordering of the files. You may need to delete a few things to obtain this free 
space.  
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To defragment the drive, select it and hit the 'defragment' button. Note that depending on 
the size of the drive and the level of fragmentation, this can take a long time. It's a good 
thing to leave overnight, since you should not run anything else while doing the defrag.  

 
 

120 Enable AGP Fast Write  

The AGP fast write BIOS setting allows the processor to communicate directly with the 
graphics processor, ignoring the need to send data through the system's memory. This 
should be enabled to provide a performance boost. You should ensure that your video card 
supports fast writes before setting this option, however.  

Almost all recent video cards do support AGP fast write. This setting is generally found in 
the 'advanced chipset features' section of the BIOS. 

 
 

121 Wifi 802.11b devices slow down 802.11g networks 

802.11g wireless devices have recently become extremely affordable, and given their clear 
speed advantage over the previous generation of 802.11b devices, they are being adopted 
quickly. 802.11g is also completely backwardly compatible with 802.11b, but... this 
backwards compatibility carries one major disadvantage.  

Connecting an 802.11b client to an 802.11g wireless network will drag down the speed of 
the entire network due to signaling compromises that need to be made to accommodate the 
older device. Expect average throughput to be about half of what it would be if the network 
contains only 802.11g devices. So if you are hosting an 802.11g wireless network, consider 
upgrading your clients to WIFI 'g' devices also.  

 
 

122 Reduce menu delays 

The Windows XP start menu incorporates a built-in delay between the time your mouse 
pointer lands on a menu and the time that menu unfolds. This can get annoying after a 
while. Using the registry, you can speed up menu response, speeding up your computing 
experience. 

First, open REGEDIT and then navigate to HKEY_CURRENT_USER\Control Panel\Desktop\  
Edit the MenuShowDelay value.  

The default is 400; lower values will speed up the start menu.  

Setting it to 0 is not a good idea unless you like 5 or 6 menus popping out at you every time 
your mouse pointer strays, but experiment to find your favorite setting. 
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123 Make 'my computer' open faster 

The Windows XP operating system automatically searches for attached and network printers 
and remote drives and folders each time you open 'my computer.' This can cause a 
considerable delay before you can actually see the icons. 

If you find yourself using 'my computer' often and gritting your teeth at the delay, there is 
an easy way to speed things up.  

Open 'My Computer.' Go to 'Tools\Folder Options...'Select the view tab and uncheck the 
'Automatically search for network folders and printers' box. Click OK.  

'My computer' will now open much faster. 

 
 

124 Disable floppy drive seek 

The floppy drive seek BIOS option sets whether your PC will attempt to detect the floppy 
(a:) drive during boot up. Whether it finds one or not, once Windows has loaded it becomes 
irrelevant, as control of hardware devices including drives are handed over from the BIOS to 
the operating system. 

Disabling the 'floppy drive seek' option in the 'advanced BIOS features' section of the BIOS 
can save you a few seconds on boot up, and since the setting has no actual effect, disable 
it. 

 
 

125 Enable quick POST/memory test 

Many motherboards have a setting in the BIOS which can instruct the system to skip 
through certain portion of the POST (Power On Self Test), speeding up boot times 
considerably. A variety of settings performing this function can be found on various 
motherboards.  

Some examples are: 'perform quick memory test,' 'quick boot,' 'quick power on self test,' 
etc. Enabling these options will cause your system to boot faster.  

Be advised that you should disable this option when you have made modifications to your 
computer's hardware, especially the memory.  
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126 Reduce wait time after XP boots 

A common performance problem with Windows XP is 'start lag,' in which the operating 
system boots up normally, the desktop is visible and usable, but programs will not start, 
and selecting icons and using the start menu are extremely slow. This can take anywhere 
from a few seconds to a couple of minutes to clear up, and can make using the operating 
system extremely frustrating, especially if you are in a hurry after the reboot.  

This delay is generally caused by Windows XP's networking services looking for other 
computers and advertising their functions over the computer's network connections.  

If this problem is driving you nuts, there is a way to reduce or eliminate the delay, though if 
you are attached to a home network, it will reduce your computer's functionality on that 
network.  

If your computer is not attached to a home network: 

Right click on 'my computer' and select 'manage.' 
Expand 'services and applications' and select 'services' to open the services window. 
Highlight the 'workstation' service, right click and select 'properties.' 
Set the 'startup type' dropdown box to 'disabled.' Click 'ok.' 
Note that you will need to re-enable the workstation service should you wish to network 
your PC in the future.  

If your computer is part of a home network: 

Go to 'start\control panel\network and internet connections\network connections.' 

Right click your current network connection (should be 'local area connection' unless you 
have more than one network adaptor) and select 'properties.' 
Uncheck the 'File and Print Sharing' box and press 'ok.' 
Note that this will disable your computer's ability to share files and printers over the 
network, though it should not affect your ability to access such resources on another 
system. 

 
 
127 Shutdown XP Faster 
 
Don’t have XP clear your paging file at shutdown 
 
HKLM\System\CurrentControlSet\Control\Session Manager\Memory Management 
   set    ClearPageFileAtShutdown = 0 
 

 
128 Schedule a Task for Idle Time 
 

• Run / Control Panel / Classic View – Scheduled Tasks 
• Double-click on Scheduled Tasks 
• Double-click on Add Scheduled Task 



Page 70 of 70 
 
C:\Documents and Settings\Terry\My Documents\SSCC May 2006\Windows XP Performance Tips.doc 
Windows XP Performance Tips  Terry Kerby  Compiled from various sources. 

• Use the wizard to schedule your task (defrag, antivirus scan, etc.) to run daily 
• Check the box titled Open advanced properties for this task when I click Finish 
• Click Finish 
• Click the Schedule tab near the top of the dialog that pops up 
• Pull down Schedule Task list 
• Choose When idle 
• Click OK 

 
That’s it.  Now the task will run when the computer is idle. 
 
 

129 Turn off BIOS disk detection 

Most modern motherboards will attempt to detect any IDE devices, such as hard drives and 
CD drives, during the POST sequence each time the computer boots. By configuring the 
BIOS with the correct drive information, you can shave a few seconds off your boot time by 
avoiding this detection process.  

To do this enter your system's BIOS setup screen.  

Depending on your motherboard, you may have an IDE drive auto-detection menu. If you 
do, simply select it to automatically set your drives. If not, configure the drives through the 
'standard CMOS settings' menu.  

Note that some motherboard chipsets (like Nvidia's Nforce 2) do not allow this auto-
detection to be disabled. 

 
 

130 Disable boot virus detection 

The boot virus detection setting is a holdover from the early days of computer viruses, when 
the greatest threat was from virus programs that wrote themselves into the boot sector of 
hard disks or the partition table. Some motherboards are equipped to monitor any attempt 
to write to these areas during boot up, and halt the process with a warning for the user.  

Since every version of Windows after 3.1 needs to write to these areas during install, and 
the modern virus style of choice is the email worm, this feature is now obsolete. Disable it 
for convenience and increased boot speed. It will commonly be found in the 'advanced BIOS 
features' section of the BIOS. 

 
 


